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[bookmark: _Toc474851162][bookmark: _Toc57632929][bookmark: _Toc1488156850][bookmark: _Toc1703559103][bookmark: _Toc219095877]Part I. 	Overview of estimates and projections tools
[bookmark: _Toc474851163][bookmark: _Toc57632930][bookmark: _Toc504271396][bookmark: _Toc1357201096][bookmark: _Toc219095878]A. 	Purpose of estimation and projection models
A well-planned response to the HIV epidemic requires accurate information on key epidemiological and programmatic indicators over time. A mathematical model is used to describe the HIV epidemic and the impact of the response because it is impossible to count the exact number of people living with HIV, people who are newly infected with HIV or people who have died from AIDS-related causes in any country over time. 
UNAIDS and partners have supported the development of the AIDS Impact Module in the Spectrum software to assist countries to monitor their HIV epidemic. Spectrum is a software that uses a mathematical model which utilizes HIV surveillance, survey and program data, combined with demographic data, to generate historical trends and short-term projections of key indicators. These indicators, including the number of people living with HIV, the number of new HIV infections, the number of pregnant women infected with HIV, mortality due to AIDS and treatment coverage, are useful in assessing epidemic trends, the overall impact of the HIV response and in planning future health care service and pharmaceutical needs.
[bookmark: _Toc474851164][bookmark: _Toc57632931][bookmark: _Toc2114551270][bookmark: _Toc1439555233][bookmark: _Toc219095879]B. 	Technical oversight of Spectrum
The UNAIDS Reference Group on Estimates, Modelling and Projections oversees the development and revision of the underlying mathematical model and functionalities used within the Spectrum software. The group is composed of experts from multiple disciplines and institutions, including epidemiologists, demographers, clinicians, statisticians, modelers, and program implementers. The Reference Group meets twice a year to discuss revisions and recommends updates to the software which are implemented annually. For more information on the Reference Group go to www.epidem.org
[bookmark: _Toc474851165][bookmark: _Toc57632932][bookmark: _Toc1447011136][bookmark: _Toc953831246][bookmark: _Toc219095880]C. 	Process of creating HIV estimates and projections using Spectrum
Country teams are responsible for creating and updating annual Spectrum files. The country teams typically consist of individuals from the national programs who have a strong capacity for epidemiology and modeling. These teams also may include in-country development partners who work on HIV surveillance. The country teams work in groups to update the estimates with the country’s most recent surveillance and program data. UNAIDS and partners support country teams to explain new features and review and validate program data and outputs. 
Countries are expected to refine and share preliminary outputs with other interested parties in the country for their review. Once results are finalized, UNAIDS uses these to inform the regional and global estimates of HIV. Countries are encouraged to publish estimates and to communicate the results to all relevant stakeholders. 

[bookmark: _Toc57632933][bookmark: _Toc801920111][bookmark: _Toc686570055][bookmark: _Toc219095881]D. 	Major changes in the 2026 software
Key changes in the 2026 software are described below. 
For details, please refer to the indicated Step in the remainder of this guide.

[bookmark: _Toc219095882]Program Statistics inputs
Users can now enter the following additional program data:

PMTCT editor: PrEP for pregnant and breastfeeding women. Inputs include the number of people on oral daily oral PrEP or long-acting PrEP as well as adherence by method, person-years of protection per person on PrEP by method, and the incidence risk ratio of those on PrEP versus all women. These serve for context and future planning. We do not expect most programs to have data on PrEP for pregnant women for 2025. If you do enter numbers for 2025 or future years, this will reduce estimated incidence among pregnant women, the mother-to-child transmission rate and the number of new child infections. 

Adult ART: A button to ‘Check interruption rates’ and warning message have been added to spot entries where the decline in number on ART from the previous year is larger than explained by the entered treatment interruption rate. This encourages users to adjust the interruption rate to a more reasonable level. If they don’t do so, then modelled number on ART will not decline as much as the input data and so mortality and incidence that year may be underestimated. 

[bookmark: _Toc219095883]Advanced Options and Parameters
Mortality rates among children on ART have been updated to the latest from the IeDEA Consortium. Users will need to select Advanced Options > Pediatric transition parameters and click ‘Restore all transition default values and exit’ to insert the updated rates. This will result in small increases or decrease in pediatric deaths on ART but in most countries, the change will be small, 1%-2%.
ART effect on transmission: This calculation is now restricted to years with >50% of ART patients tested for viral load, to ensure representativeness. If there were less than 3 years of data meeting this condition, the default reduction (of 0.75) will be used.

[bookmark: _Toc219095884]CSAVR incidence model / AIDS death data
To better evaluate the most valid inputs for AIDS-attributed deaths (among adults 15+ years) for incidence modelling, users can now plot and compare alternative AIDS death data sources (e.g., with versus without adjustment for misclassified causes of deaths) within CSAVR’s data editor, using the button ‘Plot AIDS deaths by source’.


[bookmark: _Toc219095885]Prevention Denominators Tool
This new tool, accessed through Spectrum’s ‘Tools’ menu, allows the user to estimate needs based on targets for various prevention services: condoms, PrEP, voluntary medical male circumcision, and services for Key Populations. Population sizes (for 2025 and projected to 2030), 2025-level service coverage and rates of HIV sero-discordancy (relevant to PrEP needs) have been prefilled based on published country-reported data (including but not limited to Global AIDS Monitoring reports) or other standardized public data bases (national household surveys; UNAIDS consolidated Population Size Estimates also used for Goals target setting, sustainability planning and global and regional Key Population infection estimates).
Key population sizes are based on national Population Size Estimates used in the 2025 round of Goals model calibrations. Numbers of HIV-infected pregnant women are from the 2025 round of national Spectrum AIM files and sero-discordant couples were estimated from prevalence in these AIM files. Total numbers of beneficiaries on PrEP in 2024 were taken from GAM; lacking comprehensive data on PrEP beneficiaries by single key population, those were proportionally allocated across sub-population. Users can change any of these inputs it they have more recent data. 
This tool is not meant to replace existing tools (PrEP-it, DMPPT2, Condom Needs Estimation Tool) which contain additional details, but to provide a quick assessment of needs as part of the estimates process. 
For VMMC priority countries, circumcision targets are by district as entered into the DMPPT2 tool. Users can update any of the inputs, but we expect them to focus mainly setting the 2030 targets and examining the resulting needs.  

[bookmark: _Toc219095886]Software versions  
Spectrum software is now available in two versions:
· a desktop version for Windows, that must be downloaded and installed on your computer, and 
· an on-line version, now with all the functionality of the desktop version, including EPP, CSAVR and Shiny90. 

The above summary does not include updates to related modelling tools including AEM, Naomi including the subnational viewer with VMMC coverage estimates and the Key Population workbook. Separate guidance is available for these tools.

[bookmark: _Toc474851167][bookmark: _Toc57632935][bookmark: _Toc1858991104][bookmark: _Toc2126092315][bookmark: _Toc224716510][bookmark: _Toc224716933][bookmark: _Toc224888963][bookmark: _Toc224889034][bookmark: _Toc224889227][bookmark: _Toc226958755][bookmark: _Toc227058360][bookmark: _Toc227058934][bookmark: _Toc219095887]Part II.	Using the Spectrum Software 

This section describes the detailed steps required to update your Spectrum file. A more concise summary of these steps is available in the Basic Steps document and PowerPoint, under training materials at hivtools.unaids.org.
To create a new file as opposed to updating one, please see Annex 2. 
[bookmark: _Toc227058949][bookmark: _Toc474851169][bookmark: _Toc57632936][bookmark: _Toc1728020253][bookmark: _Toc2145306714][bookmark: _Toc219095888]Step 1.	Install the most recent version of Spectrum
Spectrum can be downloaded from www.avenirhealth.org. Use the version listed under the AIM module. Spectrum will run on any computer running Windows Vista, 7, 8, 10 or 11. It requires about 500 MB of hard disk space. 
Once Spectrum is downloaded from the internet, double click on the file named “SpecInstall.exe”. This will start the installation program. Follow the instructions on the screen to complete the installation. 
If you have trouble installing Spectrum you may not have permission to install programs on your computer. In that case, contact your IT office to install Spectrum for you. 
After installing Spectrum, check your computer to make sure you have Java version 8 installed on your system. The easiest way to determine which version of Java you have is to click on the Windows start menu, select ‘All Apps’, click on Java and select ‘About Java’. If you do not have version 8 (or do not have Java), please download or update the software at www.java.com. 
Next make sure that Windows can find Java on your computer. To do this, start Spectrum and open your country file. Select Modules from the Spectrum menu and click the AIM icon to display the AIM menu. Select Incidence and Configuration (EPP). If EPP starts after a few seconds, then you are ready to use EPP. If it does not start, then you need to tell Windows where to find Java. To do that select File and Options. Click the box next to Use custom java.exe to add a check mark. Then click the button Select java.exe. This will open Windows Explorer. You need to indicate the location of the java.exe file. To find it select the C: drive, then click Program Files (x86), then Java, then click the folder for the most recent release of Java, then click bin, and, finally, click java.exe. This location will be saved so that Spectrum will always be able to find Java. If you update your version of Java, you will need to repeat this process to ensure Spectrum has the latest Java location.
Alternatively, a new web-based version of Spectrum is available at: https://aim.spectrumweb.org . See the video on Spectrum on the web at hivtools.unaids.org. The on-line version does not require any installation, and it can read and write the same Spectrum files as the desktop version, so you can share files between the two versions. 



[bookmark: _Toc474851170][bookmark: _Toc57632937][bookmark: _Toc543365687][bookmark: _Toc1438607995][bookmark: _Toc219095889]Step 2.	Start Spectrum
Start the Spectrum program by selecting it from the Start menu on your computer (Windows 7 or earlier and Windows 10 or 11) or your Start Screen (Windows 8). When the program starts, you will see the welcome screen below. 

 [image: ]

From that screen you can run different applications including Spectrum. You can also open an existing Spectrum file directly.
If you run Spectrum by clicking on the icon, the main Spectrum module will appear. 

[image: ]
From there, you will be able to select ‘New Projection’, ‘Open existing projection’, select a ‘Recently opened projection’ or use ‘Spectrum online support’ below the Getting Started header. 

	Choosing Spectrum’s default language
The first time you run Spectrum after installing it, the display will be in English. You can change to another language by selecting the Spectrum File tab, then Options, then selecting the language you want to use and finally clicking on Ok. If you select a language other than French, you must have the proper fonts or Windows version to display the language correctly.



If you have a Spectrum file from previous rounds of estimates, you should start by opening that file and following the instructions below. 
[bookmark: _Toc474851171][bookmark: _Toc57632938]

[bookmark: _Toc1321370094][bookmark: _Toc2057502625][bookmark: _Toc219095890]Step 3.	Update the population projection
If you did not update your demographic data last year, you may want to update it this year to use the latest estimates and projections from the UN World Population Prospects. When you open a projection, select the “Manager” icon which will open the below dialogue box. 

[image: ]
 [image: ]Change to 2030
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	Caution: When to NOT update the demographic data in your projection
You should not update the demographic data in your projections if:
1. You have modified the default demographic data to incorporate country-specific census data
2. You have created a sub-national projection
With an automated update to WPP demographic data, you would lose the custom data.




Follow the three steps below to update the demographic or HIV data in your projection: 
Change the final year to 2030, if this is not already the final year. The first year should be 1970 — before the start of the HIV epidemic. 
For projections using AEM (AIDS Epidemic Model), the final year should be 2050.
Projections submitted to UNAIDS should use these settings.

Click the Default Data button. 
Select your country from the list. Also select the geographic level of the file (country, sub-national, global region, a sample country or none of the above). 

Next, click the box next to DemProj to indicate that you want the demographic data to be updated to the World Population Prospects 2024. Do not update the AIM data, as this would over-write your program data. When you are done, click the OK button. 
Finally, save your file under a new name, such as Country_01Jan2026.
Now you can update the AIDS Impact Module within Spectrum. Select Modules from the Spectrum menu and click the AIM icon to display the AIM menu as shown below. 

[image: ]

To produce the projection, you advance through the menus at the top of the page: Eligibility for Treatment, Program statistics, Advanced options, Incidence, Sex/age pattern, Results, Validation. The following sections explain each of these in detail.

[bookmark: _Toc231795421][bookmark: _Toc1951895509][bookmark: _Toc219095891]Scope of national estimates
The World Population Projection’s (WPP) demographic estimates are for national de facto populations, which include all people residing in the country, whether citizens or non-citizens, with the latter including long-term residents. UNAIDS recommends that national HIV estimates use the de facto population, matching WPP demographic inputs 2024 (https://population.un.org/wpp/GlossaryOfDemographicTerms/ ). UNAIDS publishes national estimates if they are for the De facto population.
A few countries have historically limited their estimate to the de jure population (limited to legal citizens). These estimates did not provide the full national need for HIV treatment, prevention and care services. Yet they were sometimes used in conjunction with surveillance and program data (into Global AIDS Monitoring) that did include non-citizen residents, thus creating inconsistencies. For these reasons, UNAIDS recommends adopting the de facto population scope for both Spectrum estimates and program and surveillance data reporting. 
In exceptional cases, if a new Census has become available after the WPP’s 2024 update, if the WPP-based projection does not match official national statistics, you may opt to overwrite the WPP 2024 with a ‘custom population adjusted file’ (instructions in Annex 4).
[bookmark: _Toc474851173][bookmark: _Toc57632939]

[bookmark: _Toc1793957396][bookmark: _Toc2048649722][bookmark: _Toc219095892]Step 4.	Specify eligibility for treatment
In most countries, all people living with HIV are eligible for treatment. If eligibility has not changed, you can skip this update step. If not all PLHIV are eligible or if you wish to revise historical eligibility, follow the steps below.
The second table editor allows you to specify which population groups living with HIV are eligible for treatment regardless of CD4 count. To specify those populations, click the check box next to the name and enter the year in which the guidelines were changed to include that population group. As a final entry, specify the estimated percent of PLHIV in this group as a proportion of all adult PLHIV. Spectrum supplies default estimates for most countries and will calculate this estimate for pregnant women directly from the model. This second table is however only relevant for earlier years, when the CD4 threshold was below 999. 
To modify eligibility for treatment for children, click on the Children tab at the top of the editor. For children, eligibility has three different criteria:
By age. Enter the age below which all HIV+ children are eligible or are started on treatment. By default, this is set to 12 months from 2007; 24 months from 2010; 60 months from 2013: and 180 months (to age 15) thereafter. For years with the Treat All policy, set the first row to 180 months (i.e., 15 years). 
CD4 count. The CD4 count for eligibility can be defined by four age groups and by year. The default values follow WHO guidelines for the corresponding years. 
CD4 percent. Eligibility may also be defined in terms of CD4 percent by age. The default values follow WHO guidelines. 
Children are considered eligible for treatment if they meet any one of the three criteria. 
[bookmark: _Toc474851174][bookmark: _Toc57632940]

[bookmark: _Toc1014443935][bookmark: _Toc1299286966][bookmark: _Toc219095893]Step 5.	Enter program statistics
Click on the Program statistics menu item to see the program data editor. It looks like this:
[image: ]

In this editor, enter or revise program data on PMTCT, ANC testing, ART, viral load suppression, and data or estimates of knowledge of status, using the tabs at the top. 

[bookmark: _Toc1367926441][bookmark: _Toc534023359][bookmark: _Hlk150778565][bookmark: _Toc219095894]PMTCT, adult and child ART
In the PMTCT, Child ART and Adult ART tabs, enter any new or updated program data, by calendar year, either as the number of people receiving the service or as coverage, the percentage of those in need of the service who receive it (for ART, defined as the proportion of all people living with HIV). 
Enter or update program statistics for all historical years (i.e., through 2025) as numbers. For future years (e.g., 2026 through 2030), enter expected or targets coverage as a percent – since future need numbers are unknown. You can enter numbers for some years and coverage for other years, but you cannot have a number and a percent in the same year. 
In the ART and PMTCT tables, grey numbers display estimated numbers in need of the service, based on the last time the projection was run. Substantial changes to inputs (surveillance or program data, or parameter settings) will change these estimates. Therefore, consider the needs in grey as indicative values and review them again after the whole file has been updated and reprojected. 
Enter or update the original Ministry of Health reported number of people on ART into: Spectrum > AIM > Program Statistics > Adult ART and > Child ART, as usual.
The reported number on ART may need to be discounted based on a nationally representative DQA, ART coverage estimates from household surveys and/or triangulation with other surveillance and programme data. An adjustment ratio can be entered into Spectrum’s ART editor, for years applicable. It is recommended that any DQA-based adjustment is extrapolated back to zero over several years preceding the DQA, to prevent sudden decreases in ART coverage over time. See WHO Data quality assessment of national and partner monitoring data and system implementation tool – Second edition Annex C: National adjustment of ART data example (XLS).
For adult ART, countries with detailed information about the CD4 count profile of all people initiating ART may exceptionally opt to enter ART data ─ as either a percent coverage or the number of patients started in each of four CD4 count categories ─ but this option is not recommended. 
Also enter realistic annual percentages of patients who interrupted treatment, for each year with ART data entered. This is important for Spectrum to project the correct mix of people continuing ART, as well as new treatment initiations and reinitiations, and thereby estimate realistic distributions of patients and PLHIV in terms of age, CD4 cell count, and mortality risk. Please use the definition and calculation that best captures longer-term treatment interruptions of patients who were not quickly traced and re-initiated on treatment – i.e. those interruptions with real risk of CD4 rebound, and clinical impacts – but not include  deaths (which Spectrum will calculate) or silent transfers. 
The best definition will differ by the structure of the ART program (scale of roll-out of Differentiated Service Delivery and ARV dispensing intervals), and data systems (with or without records of last expected clinical contact, and medical refills). Please enter your definition and calculation method (e.g. x days or months since last actual contact, or since last scheduled or expected contact) in the note pad accessed by click the ‘Source’ button.
If you have interruption data for one or a few years, apply the same percentage for years before (back to the first year of ART) and after (until end of projection). Specify the source: nation-wide program data, or selected clinics?
If you have no data or your data are unreliable for some or all years, put the UNAIDS-recommended global default:
· 1.6% treatment interruption for high-income countries;
· 5% treatment interruption elsewhere;
-- for both adults and children, annually, by clicking ‘Apply default interruption rate’.

If your country conducted any ART cohort patient tracing studies, those may serve to validate or substitute for national program data on treatment interruption– please share and discuss with your UNAIDS estimates advisor.  

The child ART data entry tab provides two options for entering the number of children on ART: (1) ART among all children 0-14 years combined and (2) ART by 5-year age group. If you know the number of children on ART by five-year age group, you should enter these here in the Child ART tab (and not only in the ART by age tab, described below). These will inform Spectrum’s allocation of ART by age. The choice of entering for all children or by 5-year age group can vary by year, so if age-disaggregated data are only available in some (e.g., recent) years, they can be entered for those years available. 
As for adults, enter the annual percentage of children who interrupt treatment each year, and explain your definition and calculation method, taking care to count only patients who dropped out, not those who have died on ART or silent transfers to another facility). If you have no data, adopt the regional default interruption rate, by clicking ‘Apply default interruption rate’.
For both adults and children, also enter the numbers initiating ART (among adults, disaggregated by sex), and those reinitiating treatment after dropping out, for all years known. These data are used in Validation outputs (ART > Previously Treated population) and in the ART Waterfall analysis located in Program Statistics. 

On the PMTCT tab, update retention at delivery and the monthly drop-out rate during postnatal prophylaxis for all years based on national or nationally representative program data if available. For years without data, consider adopting the default value (based on a review of published literature) of 80% or a plausible value based on overall adult retention on ART. 
During breastfeeding the default monthly rate of drop off from ART is 1.2% for those on ART since a duration of 0-12 months and 0.7% for those on ART since 12+ months. 

[image: ]
For countries with generalized epidemics, update breastfeeding patterns based on survey data. 


For countries with a generalized epidemic, click on the Breastfeeding button and the Read survey data button (see panel below) to update the breastfeeding patterns among women not receiving ARVs. 
The Abortion button provides you the option to enter the percent of HIV-positive pregnant women terminating pregnancies. This should only be used for abortions that are specific to HIV infection and not that might occur to any women, regardless of HIV infection. Spectrum’s estimate of HIV prevalence in pregnant women will exclude entered abortions among HIV+ women from its numerator and so be lower, thereby increasing PMTCT coverage, lowering MTCT and CLHIV, and increasing child ART coverage. 
[image: ]For countries with generalized epidemics, update breastfeeding survey data patterns. 


[bookmark: _Hlk500230857]Once you have updated the PMTCT and ART program data, you can use the “plot” feature in Spectrum to visualize these data over time. To access this feature, click on the Plot Values button on any of the PMTCT, Adult ART and Child Treatment tabs. For Adult ART and Children treatment plot, a check button in the upper left corner allows you to plot needs against eligibility.
Also on this screen, update your planned scale-up of ART coverage through 2030. Projected values should be realistic based on recent trends or expected changes in resource commitments. 
When you are finished entering and checking PMTCT, ANC testing, child treatment data, testing and treatment cascade data and future targets, click Ok to save your entries. 

[image: ][image: ][image: ][image: ]

[bookmark: _Toc1168093709][bookmark: _Toc729717739][bookmark: _Toc219095895]ANC testing
Please update and review data on HIV testing during routine antenatal care (ANC) visits for all years these had high coverage nation-wide or were nationally representative. Any unexpected fluctuations, trends or patterns may indicate data quality issues that need to be resolved before fitting prevalence to routine ANC data (whether for fertility or for adults overall in EPP) and interpreting MTCT and child estimates. 
From the entered ANC visit and testing data, this table calculates an estimate of ANC prevalence, which determines the need and therefore the proportional coverage of PMTCT and has an important impact on children living with HIV and thus pediatric ART. 
To complete this tab, compile routine HIV testing data summing all ANC sites in the country. Enter the data, use the graphs to look for discrepancies and use the “Check table values” button to verify that the data meet logical expectations for the ANC testing cascade.

[image: ]
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# of births: the number of births in the country, from the DemProj module. It is greyed out, because it is automatically populated by the software
# of program reported births: the annual number of births reported by the program, if available. This will be compared with the number of births estimated by Spectrum and the number of first ANC visits, to detect any discrepancies. 
# first ANC visits: the total number of women who have visited ANC clinics at least once in the area currently being modeled in EPP for the current pregnancy. Do NOT include repeat visits in this count. Do include women who were seen first at delivery.
# receiving at least one HIV test: the total number of women who were tested at least once during their ANC visits (or who received a first HIV test at delivery). This includes both those testing positive and those testing negative.
# testing positive at their first HIV test: the number who tested positive at their first HIV test (or at first test at delivery) during this pregnancy. This should not include women who received multiple tests and were positive only at the second or third test.
# re-tested: the number who received a second or third test during their pregnancy.
# positive at re-test: the number who tested positive at the second or third test.
# known to be HIV positive at (i.e. before) first ANC visit (including on ART): This is the number of women who were already known to be positive before the ANC visit and, therefore, recorded as positive, but who did not receive an HIV test. This should include women who are already on ART.
# known to be HIV negative at first ANC visit (optional): In some countries women are not tested for HIV if they had a documented negative HIV test in the past few months. 
# started ART before current pregnancy, number started ART during current pregnancy > 4 weeks before delivery and <4 weeks before delivery: these data are filled by Spectrum, pulling entries for these PMTCT B+ options from the PMTCT editor. Compare # started ART during current pregnancy (the sum of the 2 PMTCT options) with your entry for # testing positive at their first HIV test, and compare your entry for # started ART before current pregnancy with # known to be HIV positive at first ANC visit, for consistency. 
% HIV+ (census level ANC-RT): If using EPP-Generalized for the incidence estimation, this is calculated by Spectrum, pulling a weighted average of entries from EPP’s Surveillance Data editor, the Census-level ANC-RT (top) row in each subpopulation or subnational region; see Step 9 below).  
% HIV+ (calculated): This is calculated by Spectrum, from the entries above within the ANC testing editor. The numerator is: Women testing positive at first HIV test + women known to be HIV positive at/before first ANC visit; the denominator is: Women who received at least one HIV test + women known to be HIV positive at/before first ANC visit. If using EPP-Concentrated for the incidence estimation, this prevalence calculation can be copied as entry to EPP > Surveillance data for the Remaining (non-Key Population) population(s).

Progress towards 95-95-95, Knowledge of Status, ART by detailed age group, and Viral suppression: Progress towards the first and third 95s are compiled in Spectrum alongside the numbers of adults and children on treatment. Viral suppression (the third 95) influences Spectrum’s estimation via its effect on transmission and incidence; in contrast, Knowledge of Status (first 95) does not influence the epidemic estimation and is typically revisited and finalized after fitting incidence (through EPP, CSAVR or AEM). 

[bookmark: _Toc151689045][bookmark: _Toc702660426][bookmark: _Toc219095896]Knowledge of Status
First select the source of the data or estimate to be entered, for adults. 
You will see several options:
[image: ]

Shiny90, for countries with household surveys that include HIV testing
Countries with one or more nationally representative population-based HIV surveys that included HIV serology should estimate the trend for the first 95 among adults using the Shiny90 model, a standardized methodology that combines household survey with routine programmatic testing volumes and case diagnoses, and produces a robust estimate for all years that is comparable over time and with other countries. This application is accessed from the Spectrum-AIM-Knowledge-of-Status-Shiny90 tab with functions to ‘Load default data’, View/Edit inputs, and Fit Knowledge of status.
After completing these three steps, estimates of the first 95 for adults by sex will appear in the table: 
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Knowledge of status directly from Case reports
Countries without a serosurvey can enter cumulative case surveillance data, if case surveillance is of good completeness and quality, nation-wide and covering 2015-2025 or longer, and after subtracting cumulative (all-cause) deaths and emigrations among diagnosed PLHIV. 
Select the radio button ‘Case reports’. The number of PLHIV who know their status is calculated as: cumulative new (first-time) case diagnoses, minus cumulative deaths to diagnosed PLHIV (from any cause), minus cumulative emigrations of diagnosed PLHIV. Include all new diagnoses, that is first-time diagnoses, once, after removing duplicates. It is also critical to subtract deaths and emigrants, otherwise Knowledge of Status will be overestimated. 
UNAIDS recommends creating estimates for the de facto population, the population currently residing in the country, including citizens and non-citizens. Accordingly, both citizens and non-citizens should also count into Knowledge of Status, so if entering HIV-infected immigrants into AIM, these same numbers should be included into your calculated numbers of PLHIV knowing their status for the same year, in AIM Program Statistics. Specifically, every immigrant diagnosed for the first time in the country (whether or not previously diagnosed in the country of origin) should count into Knowledge of Status (just as all ART and PMTCT numbers entered should include all resident PLHIV concerned, whether citizen or foreign-born). 
If you know cumulative new diagnoses, deaths and (if applicable) emigrations by calendar year, enter your resulting estimate of PLHIV diagnosed and known to still be alive, separately for adult men, women and children for each end of calendar year going back to 2010, as far as available. 
You may wish to review your reports to GAM from 2015-2025 (Indicator 2.1) to trace back the knowing-status numbers previously reported. In UNAIDS regional and global estimates that sum across countries, numbers you report through a newly submitted Spectrum file will replace historical estimates previously submitted into GAM, so all should be reviewed carefully for accuracy.

CSAVR estimate of knowledge of status
If case surveillance or vital registration data have limitations, for adults a CSAVR (or ECDC model or other modelled, direct input) estimate is preferred. Those have the advantage of producing a standardized estimate for all years, comparable over time and among countries, that accounts for diagnoses, deaths and emigration. 
Countries using CSAVR can import CSAVR’s estimates of knowledge of status among adult men and women. To import the CSAVR estimates, in Spectrum-AIM click on the CSAVR radio button, then click on Load Data. Estimates of the first 90 for adults by sex will appear in the table, for all years including future years. 
Loading CSAVR or Shiny90 estimates of knowledge of status should be done after finalizing program data (ART, etc.) and running the final new national Spectrum estimate.
Countries with knowledge of status estimates from the ECDC incidence model should set the radio button to ECDC, and manually enter its estimated number of people who know their HIV status. 
When knowledge of status numbers directly drawn from case and death reports exceed the CSAVR, ECDC or other incidence model’s estimated PLHIV for any year, this probably reflects that some deaths or emigrations were missing from the calculation. The CSAVR/ECDC model estimate of Knowledge of Status (coherent by design) is then preferred. Countries without a household survey (a prerequisite for Shiny90), unable to subtract deaths and (if applicable) emigrations from case reports and without a CSAVR-based or other modelled estimate should leave the adult Knowledge of Status blank. 
The KOS editor also has a data entry section for CD4 count at initial diagnosis, the number of new diagnoses, and the number of diagnoses tested for CD4 over time. CD4 count at initial diagnosis indicates the timeliness of diagnosis. Total annual numbers of new diagnoses furthermore provide context to annual changes in numbers of PLHIV knowing their status. Data entry into this editor should include only true new diagnoses, i.e. exclude previously diagnosed cases re-diagnosed upon immigration. This data entry does not affect modelling results.

Children
Enter numbers of children who know their status. You may calculate these from national routine case diagnosis reports, for all (historic) years available (but leave this blank for future years), subtracting all deaths and emigrations of diagnosed children. 
If reliable data on knowledge of status among children are not available for any or all years, instead let Spectrum calculate these based on your entries of children on ART and annual treatment interruptions, and Spectrum-estimated mortality among children on ART, by clicking ‘Calculate child KOS’. This has the advantage of producing a value for all historic years, by a standardized method. If estimated Knowing-Status exceeds estimated children living with HIV, revise (lower) the input on numbers of children receiving ART.  

[bookmark: _Toc1186109048][bookmark: _Toc1517829542][bookmark: _Toc219095897]ART by age
On the ART by age tab, enter in data for all people currently on treatment, disaggregated by 5-year age group and sex. If those data are not available use GAM age groups. These totals should add up to the child treatment and adult ART totals, respectively. Although these data are not used in the model fitting stage, these data are used when validating the model (on the Validation tab), as an essential validation step for your file.
Screen for 5-year age group ART data: 
[image: ]

Screen for GAM age group ART data: 
[image: ]

[bookmark: _Toc886107141][bookmark: _Toc258132609][bookmark: _Toc219095898]Viral load suppression
On the viral load suppression tab, select the radio button describing the source for 2025 data. 
For countries using program or case surveillance data, numbers of people reported annually to have received a viral load test should be entered first. At the bottom of the table, a percentage will be calculated showing testing coverage among people on treatment. 
If testing coverage is greater than 50%, viral load suppression is calculated as the proportion suppressed among those tested multiplied by the number of people on treatment. 
If testing coverage is below 50%, data on the numbers of people virally suppressed should not be entered, unless access to testing is believed to be unbiased with regard to geographic location or facility level. 
If sex and age disaggregated data are not available, it is possible to assume some distribution to obtain the known overall total. Assumptions used to inform the age and sex disaggregated data should be included in the source notes. 
Note that the above approach assumes that suppression levels are the same among the untested and tested populations. If there is evidence that this is not true, please discuss this with the Estimates team at UNAIDS. 
For countries using survey data to report, please remember to extrapolate the results to the total number of people living with HIV in the country. Also, enter the numbers of people with an annual viral load test, even if the results from these tests are not used to estimate suppression. 
[bookmark: _Hlk25770173]For countries that report suppression using an assay with a detection threshold below 1000 copies/mL, you can adjust the results to reflect the numbers expected to be suppressed at the recommended 1000 copies/mL. The detection threshold can be entered for each year and the adjustment will be made automatically made and visible as a separate category in Results in the disaggregated HIV testing and treatment cascade. This will ensure the data reported by countries with different thresholds are comparable.

[bookmark: _Toc781555152][bookmark: _Toc1328942736][bookmark: _Toc219095899]HIV test volumes
Please enter, for years available: Total HIV diagnostic tests; Total HIV-positive tests; Tests in HIV testing clinics / services (HTC/HTS); HIV-positive HTC/HTS tests; Self-tests; Index partner tests. Also enter HTC/HTS tests separately for men and women each, by GAM age group. These do not affect model results, but serve as context to interpreting trends in new diagnoses and knowledge of status estimated by the Shiny90 or CSAVR model.

[bookmark: _Toc474851175][bookmark: _Toc57632941][bookmark: _Toc1979281411][bookmark: _Toc237553774][bookmark: _Toc219095900]Step 6. 	Update default parameter values in Advanced options
The Advanced options menu allows you to see the default adult and child parameter values used in the projection. These parameter values are informed by special studies and surveys from many sites around the world. In most cases the default values should be used and you should update these every round of estimates, by selecting Restore Defaults. You should only change them if you have conclusive evidence for alternative values. The parameter groupings are as follows:

[bookmark: _Toc2105684786][bookmark: _Toc291090079][bookmark: _Toc219095901]Pediatric transition parameters
These tabs include assumptions around progression rates to lower CD4 levels, the distribution of new infections by CD4 percent, HIV-related mortality for children with and without ART and the probability of initiating ART by age. Assumptions about the effectiveness of cotrimoxazole on reducing mortality over time are also included.

[bookmark: _Toc2063442082][bookmark: _Toc204240922][bookmark: _Toc219095902]Adult transition parameters
These include the amount of time an average adult spends in each CD4 category, and the distribution of new infections by CD4 category.
HIV-related mortality among people without ART is specified by CD4 category, age and sex. 
HIV-related mortality on ART is specified by age, sex and CD4 count at the initiation of treatment, as well as by a scaling factor adjusting annual mortality rates relative to 2016. Different default patterns are proposed by region for HIV-related mortality. In the tabs for HIV-related mortality, select the country’s region to tailor your mortality estimates. 
Background: Spectrum’s mortality rates are based on cohorts of patients on ART. They reflect excess mortality among PLHIV. The excess mortality is comprised of AIDS-attributed deaths and other causes of deaths for which HIV infection increases risk. In places with high ART coverage and with an ageing cohort of PLHIV, AIDS mortality is falling and non-AIDS mortality rising among PLHIV, due to common comorbidities including certain non-communicable chronic diseases). Here, Spectrum-estimated mortality may exceed AIDS-attributed mortality in vital registration data. If needed, you can use the Mortality on-ART multiplier. This multiplies all on-ART mortality rates up or down by the user-entered scaling factor. This is generally not recommended. Only a few countries with exceptionally good mortality data for PLHIV and high ART coverage may need this adjustment, if Spectrum’s default mortality rates fail to fit the low death numbers observed.

Reduction in HIV transmission when on ART (omega)
Under Adult Transmission parameters, the HIV mortality on ART tab also has the parameter that sets the reduction in HIV transmission from ART – expressed as percentage reduction in adult HIV transmission per percentage point increase in adult ART coverage. This parameter is used by EPP, AEM and CSAVR with the r-Logistic (but not CSAVR’s other) incidence models.
The ART effect is country-specific and calculated from national viral suppression data (averaging the last 3 years of viral suppression data entered). After ‘Restoring defaults’ for the other adult transition parameters, go back to this tab and click ‘Calculate ART effect’. This is calculated as (average viral suppression, among PLHIV on ART, over the past 3 years as % – 0.07) or 0.7, whichever is larger. For example, with average:
· 95% Viral suppression à ART effect = 0.88 
à lower recent incidence (relative to the default ART effect of 0.8)
· 60% Viral suppression à ART effect defaults to the minimum of 0.70 
à higher recent incidence (relative to the default ART effect of 0.8).

If fewer than 3 viral load data points were entered, the calculation resets to a default value of 0.80, used for all countries up to the 2022 estimation round.  This reflected historically observed average effects of viral suppression on HIV transmission, adjusted for the age profile and sexual activity of PLHIV on ART (who are generally slightly older than PLHIV not on ART).
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[bookmark: _Toc144550995][bookmark: _Toc213260608][bookmark: _Toc219095903]HIV-related fertility reduction
The HIV-related fertility tab contains the parameters for estimating births to women living with HIV. The effects of HIV on women’s fertility, by age and CD4 count and separately for women on and off ART, are expressed as ratios relative to uninfected women. It is important to have fertility among women with HIV correct in Spectrum, since this determines the prevalence among pregnant women, and so the need for and coverage of PMTCT, the number of children living with HIV and pediatric ART. 
The effect of HIV on fertility among women 15-19 is dependent on the proportion of women in that age group that are sexually active. Since this varies considerably across countries, you can calculate the correct adjustment factor for your country by clicking the button ‘Calculate 15-19-year-olds’. This will estimate the adjustment based on the percent sexually active from the latest national survey. You only need to do this when a new survey is completed.  
Fertility can be further adjusted by fitting to national-level routine ANC prevalence data, by selecting Fit Local Adjustment Factor. Read in HIV prevalence among ANC attendees, from the ANC testing and seropositivity data entered in the Program Statistics > ANC Testing tab by clicking ‘From program data’. If the Read ANC-RT data button is not active, that means that no data are available on HIV prevalence among pregnant women. 
If new routine ANC data are being entered, this step should be repeated after those data have been entered. Also, every time that the incidence estimates (from EPP, CSAVR or AEM) or the Incidence Rate Ratios by sex changes, please also refit the fertility Local Adjustment Factor, so that prevalence in pregnant women again aligns with the overall adult estimate.

In settings without universal routine testing among all women attending ANC clinics, fitting ANC data should not be done unless these data are believed to be of high quality and representative of all pregnant women. 
ANC-based prevalence data points may not be correct for the estimated population and not used to fit a Local Adjustment Factor if:
· HIV testing is limited to certain sites (e.g. only in urban areas);
· If women’s attendance in ANC is less than 85-90 percent and selective, for example, if higher-risk women do not attend ANC early in the pregnancy for fear of stigma or, conversely, if HIV testing at ANC is targeted at higher-risk women;
· If observed ANC prevalence, ANC visits or registered facility births fluctuate by more than 20% from year to year. This may indicate that one or more data points are not representative;
· If numbers of ANC visits or women whose HIV status is ascertained at ANC are greater than the estimated births, this may indicate duplicate reporting (for example the data may include results from repeat tests of women found negative at first test);
· If observed ANC prevalence is very inconsistent with prevalence estimated from representative surveys or studies.
See list of criteria that should be applied before using ANC routine testing data in Step 9.

If fertility and prevalence fit through the Local Adjustment Factor, combined with PMTCT data believed of good quality, results in an estimated PMTCT or pediatric coverage over 100%, ANC-reported prevalence may be below the actual HIV prevalence among all pregnant women. You may want to reset the Local Adjustment Factor to 1.0.
If no representative routine ANC data or ANC survey data are available, ANC prevalence and PMTCT need will be estimated using the regional default fertility patterns, or could exceptionally be scaled by manually scaling the ‘local’ factor to produce plausible PMTCT and pediatric ART coverage. This is not generally recommended or needed; for countries with very low HIV prevalence at ANC (operationalized as <50 women needing PMTCT in the last year of program data) or no ANC prevalence data, UNAIDS recommends to not use or publish PMTCT or children living with HIV or pediatric ART coverage estimates. 
If, in the PMTCT editor, you entered (an elevated) frequency of abortions by HIV-infected women, when fitting a Local Fertility Adjustment Factor, the "Spectrum-calculated data" that this calibrates to will exclude women with HIV whose pregnancy was terminated via abortion (i.e. Spectrum assumes that such abortions occur before ANC-based HIV testing). Thereby, (P)MTCT estimates based on a fitted fertility adjustment are typically not altered by user-entered abortions (i.e., user-entered abortions influence PMTCT results only if not fitting fertility to ANC prevalence data).

[bookmark: _Toc188422120][bookmark: _Toc1313451280][bookmark: _Toc219095904]MTCT transmission probabilities
The table provides the assumptions around the transmission from mother to children based on the mother’s CD4 level and different ARV regimens. These probabilities are taken from the published literature and should only be changed in countries with strong evidence for alternative values. If the values in this table are red, it implies that the values do not match the current default values. 

[bookmark: _Toc37909370][bookmark: _Toc428139296][bookmark: _Toc219095905]DALYs and Orphans
These pages provide the assumptions around the calculation of disability adjusted life years and orphans. 

[bookmark: _Toc821128204][bookmark: _Toc835164484][bookmark: _Toc219095906]Allocation method for new ART patients
This allows you to change how ART is allocated to new patients by CD4 category. In Spectrum, ART is allocated to the eligible population according to their CD4 count and the expected mortality of those who have not yet started ART. By default, these are weighed as 83% to the eligible population and 17% based on their mortality among those not on ART. You can test the effects of different allocations on mortality by changing one of these weights. The other will automatically update so that both sum to one. Alternatively, you can also choose to assign the distribution by CD4 count of new ART patients to be: proportional to the mortality rate, proportional to the number eligible or to those with the lowest CD4 counts first.

	How can I update to the default values for some parameters without losing my custom values for others? 
Custom values are identifiable by their red font (although the red font may also indicate an out-of-date value). To update all parameters but not lose those that are customized, copy and save your custom values in an Excel file first, then, in Spectrum press Restore default value and finally re-enter (from Excel) the custom values. 




[bookmark: _Toc348437321][bookmark: _Toc348445102][bookmark: _Toc348614032][bookmark: _Toc350240677][bookmark: _Toc474851176][bookmark: _Toc57632942][bookmark: _Toc507263298][bookmark: _Toc203047336][bookmark: _Toc219095907]Step 7.	Select the adult Incidence fitting method in AIM
To select the Incidence fitting method, choose one of six options from the drop-down menu in the Incidence window. The method used in the previous year will be selected by default. 
[image: ]

Review the decision tree below and the quality and quantity of surveillance data available for your country, to choose the best model for deriving incidence in Spectrum. 

Countries that have conducted sentinel surveillance among women attending ANC, or among key higher-risk populations, have typically used the EPP model to fit prevalence to these surveillance data. 
For concentrated epidemics, if sentineI surveillance data among key populations are sparse but case surveillance data are relatively complete and the quality of data on AIDS-related deaths from the vital registration system is relatively high, then incidence trends can be estimated from these data using the CSAVR or ECDC model. 

Figure 1: Decision tree on use of EPP and CSAVR incidence estimation models*
[image: ]
 * Some countries use an alternative incidence model, e.g., AEM or ECDC. Their incidence rates can be directly entered into Spectrum. 
** Select an appropriate statistical model for each sub-population modelled individually. The resulting national incidence and prevalence curve may be comprised of different models for the respective sub-populations.
‘Consistent site’ = Same site (geographical location), sampled in the same way in at least 3 separate years.

[bookmark: _Toc219095908]EPP
To use EPP, select EPP in the drop-down menu, then choose the age group that best reflects your surveillance data. For countries with ANC surveillance or population survey data, this should be adults’ ages 15-49 years. 
[bookmark: _Hlk207809015]All EPP users should check (activate) the box for EPP prevalence adjustment, to allow AIM to adjust for small differences in the prevalence trend fitted by EPP as compared to the trend fitted by AIM. The maximum adjustment factor of 10 will ensure the resulting prevalence trend will closely match the prevalence curve from EPP. A lower value of the maximum adjustment factor will produce a smoother incidence curve, especially in the first decade of the epidemic, but the prevalence trend may differ from the curve fit in EPP, so this is generally not recommended. 
 [image: ]

For countries fitting subnational epidemics within a generalized-epidemic EPP configuration, the most suitable EPP statistical model can be decided independently for each geographical area. 

[bookmark: _Toc219095909]Other incidence estimation models
The non-EPP incidence fitting options are:
CSAVR: The Case Surveillance and Vital Registration fitting tool estimates incidence by fitting to program estimates of the AIDS deaths, new HIV case reports and CD4 count distribution at diagnosis. This option may be best for countries without good surveillance prevalence data but with good case surveillance on case reports and AIDS deaths from vital registration. 
ECDC model – This imports annual within-country HIV incidence numbers among adults from the ECDC HIV modelling platform tool, fitted to HIV and AIDS case diagnoses with or without individual case-based information on CD4 count at diagnosis, and, optionally, pre-migration infection among immigrants. For more information, please access: https://www.ecdc.europa.eu/en/publications-data/hiv-platform-tool. 
[bookmark: _Hlk501532801]To pull the ECDC model’s incidence estimate, under Incidence > ECDC click the ‘Read from database’ button, then select the ECDC output file (named something like COUNTRY_Result_main.csv). This file is produced automatically when completing a run of the ECDC model. Once you select the file, numbers of new infections will be read into Spectrum and displayed in the editor. Incidence will be calculated and displayed in the second row. You could subsequently edit these numbers if necessary and Spectrum will recalculate incidence accordingly, but normally they should remain as read from the ECDC file. Click the Ok button to confirm and use this incidence pattern in the Spectrum projections. 
· AEM: The AIDS Epidemic Model simulates transmission between key and lower risk sub-populations dynamically over time, based on historic prevalence, risk behavior and program coverage data. AEM then feeds the national trends along with the trends by subpopulation into Spectrum-AIM. AEM is used by 13 countries in Asia. 
· To import an incidence trend estimated by an external, non-Spectrum (statistical or transmission) model, select the Direct incidence input option. Then, enter its adult incidence trend estimate for all years up to 2025 and click Ok. 

Once you have selected the incidence model, click OK and then again click Incidence in the menu to get to the fitting steps for the selected model. 
· For EPP these steps are Configuration, Surveillance, Curve fitting, Restore values, and Review. These are discussed in turn in steps 8 through 10 of this guide. 
· For CSAVR, the menu option Fit Incidence to CSAVR should be visible, described in Step 11 of this guide. 
· Steps 12 to 20 are for all countries, irrespective of the incidence model (EPP, CSAVR or other).

[bookmark: _Toc10589354][bookmark: _Toc36415714][bookmark: _Toc219095910]Triangulating alternative incidence models
As of 2022-23, some countries have enough years of both surveillance, survey and routine testing data available to run both a prevalence-driven (e.g. EPP or AEM) and a routine reports-driven model (e.g. CSAVR or ECDC). 
If enough data are available over time, by sex and by key population, and capacity allows, it is advantageous to run two suitable models alongside each other, compare the results, and evaluate and try to explain the differences and uncertainties. For example, if EPP gives a higher estimate than CSAVR, question whether prevalence data oversampled higher-risk population, or whether HIV/AIDS case diagnoses and deaths were under-reported. Or in the opposite case, question if key population sizes were under-estimated, or if there are duplicate (repeat) HIV/AIDS case diagnoses. 
Models can also be compared for plausibility and coherence of the cascade of care: reported numbers of PLHIV knowing their status should not exceed estimated PLHIV, and ART and PMTCT coverage should not exceed 100%, for any year and group.
If you are undecided between EPP and CSAVR, and have enough quality data for both, please run both for comparison purposes. To run and triangulate both models in Spectrum, store both within the same ‘master’ Spectrum file, to avoid double data entry, inconsistencies in program data used in the alternative models (all models use the same ART data), and for ease and clarity of file management. After data entry, to compare results between the alternatives, save the ‘master’ file in turn as a CSAVR variant and an EPP variant, with different names – using ‘File -> Save projection as...’ within Spectrum. Finally, open both files in parallel, to generate and visualize the comparative results (see Step 19, Comparing alternate projections). 
The final model choice should be based on plausibility of results, e.g. coherent cascades over time and across groups, not on precedents of past estimates. Nevertheless, large changes from last year‘s estimates should inspire special scrutiny and warrant a clear consensus explanation for the direction and magnitude of change.
	I’ve selected one of the menu items in EPP – why can’t I see the program?
If you do not have the Java Runtime installed on your system, the first time you go to run an incidence calculation, you will see the following prompt within Spectrum to download and install Java before proceeding:

[image: ]

Click on “Download JAVA” and you will be taken to the Java site, where you can click on “Free Java Download” followed by “Agree and Start Free Download” to begin the install. When asked if you want to “run or save this file?”, click on “Run” and follow the prompts to install the software. 
As an alternative, you can visit the site java.com and install the Java software directly from there prior to running Spectrum. To install Java, you must have administrative rights to your computer. If you cannot successfully add this program, please contact your IT department. 
If you do not see this error message but EPP still does not run, it may be because you have two versions of Java on your computer, for example Java 7 and Java 8. EPP will not run if both versions are present. The two options to fix this issue are the following:
(i) in Spectrum, go to file -> options, check the “Use custom java.exe file” box and then click on “Select java.exe”. Browse to your Java 8 executable that can be found in your C:\Program Files (x86)\jreYYY\bin , where YYY is the Java version number. Please note that in Spectrum 2026, you must be using Java 8 or EPP will not run.
(ii). You should go to Control Panel, and use Uninstall Programs to uninstall the older version of Java unless your institution has installed software requiring an older version of Java. 




[bookmark: _Toc474851177][bookmark: _Toc57632943][bookmark: _Toc57904128][bookmark: _Toc1393213996][bookmark: _Toc954306602][bookmark: _Toc219095911]Step 8.	EPP Incidence: Configuration
The EPP module can produce adult estimates and projections for countries and sub-national regions with either generalized or concentrated epidemics. The epidemic typology and the amount and type of prevalence data available determine how you should configure EPP. The most common structures for the two configuration options are described below: 
Generalized Epidemic
Historically, in countries with generalized (typically high burden) epidemics, prevalence rose earlier in urban than in rural areas. Most of these countries have adopted an EPP configuration distinguishing urban and rural sub-populations, matching the structure of the national HIV surveillance system and prevalence reporting, anchored in periodic sentinel surveillance of pregnant women attending ANC clinics at selected sites. Since around 2017, ANC-based sentinel surveillance has been supplemented and more recently substituted by routine HIV testing in ANC. The routine data can include data from the previous sentinel sites, as well as census-level aggregated prevalence from all sites in the specified geographic area. 
Most of these countries also conducted one or more national or nationally representative household surveys that measured HIV prevalence among adults in the general population, to which the EPP calibration is anchored for the HIV prevalence level. In EPP, 
HIV prevalence from ANC testing (sentinel surveillance and routine testing) and - if available -across successive household surveys inform the time trend in EPP-estimated prevalence; whereas the prevalence level is anchored to prevalence observed in the population-based surveys. 
Concentrated Epidemic
Countries whose HIV epidemic was initially more concentrated among a few key populations and low-level among the wider population have historically focused HIV surveillance on key subpopulations most at risk for acquiring HIV (e.g., people who inject drugs, gay men and other men who have sex with men, female sex workers, transgender people and prisoners). The EPP configuration ‘Concentrated epidemic’ mirrors these surveillance systems: it models a national epidemic by producing and then aggregating epidemic curves for all locally relevant key populations with surveillance data, as well as separate curves for the remaining population of men and women at lower risk.
Key population data entered and fitted are HIV prevalence and population group size for each subpopulation modelled. Prevalence data come from serosurveys (e.g. Integrated Bio-Behavioral Surveys) and sentinel surveillance. Routine HIV testing data among pregnant women attending ANC, if universal or in a representative number of ANC facilities, can also be used as an input to the model, for the remaining (non-key population) adults.
Each population at risk requires an estimate of its population size and HIV prevalence data over time. For example, if a country identifies female sex workers and men who have sex with men as important at-risk populations, the populations modelled should be those two sub-populations and the remaining adult population, split into men and women; each of the 4 groups will require a minimum number of prevalence data points and an estimate of population size. 
Of note, it is increasingly difficult, and often irrelevant, to categorize countries as having generalized or concentrated HIV epidemics; countries with formerly recognized generalized epidemics experience appreciable HIV transmission between sex workers and their clients, among men who have sex with men and people who inject drugs. To match the structure of Spectrum, this guide continues using the terms to denote the two EPP configuration options, without implying program or surveillance priorities going forward. 

Finally, some countries may configure EPP as provincial sub epidemics (within 1 Spectrum file), with or without urban/rural or key population subpopulations, or create separate files for each geographic subdivision. If separate subnational files are developed, each file must contain surveillance, program and epidemiologic data specific to the subnational area, and demographic data aligned to the WPP 2024 national demography projection.

To update your EPP estimate, the first step is to review the epidemic structure. Normally, if you are updating an existing Spectrum file, you will not need to change the epidemic structure or the sub-population characteristics. If you do change it, be sure you have both population size data and prevalence data for any sub-populations you add.
To change the epidemic structure:
8.1	Right click on the top entry under National epidemic structure. Select the appropriate template. There are two template options: Concentrated (C) and Urban/rural (G). Most countries with generalized epidemics use the Urban/Rural template. Most other countries use the Concentrated template. See additional information in Annex 1.

Tip: Countries with well-documented epidemics in which HIV in the general adult population exceeds 1% (such as Russia) yet a significant portion of new infections continue to occur in key population groups, should continue to use the Concentrated epidemic configuration.

[image: ]8.1


Alternatively, create a custom template by left clicking on the top entry and then add or delete sub-epidemics or sub-populations using the buttons to the left, as shown below. For each sub-population, be sure to select any special characteristics it may have. To rename an item, right click it in the epidemic structure tree and choose "Rename".

Review sub-population characteristics:
8.2 	Highlight the sub-population in the epidemic structure.
8.3	Click on the characteristic of that sub-population (for example, sex workers should be “FSW” and the “General pop women” “low risk”). Repeat for each sub-population.
8.4 	Click “Save and continue”.
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8.2


[bookmark: _Toc1148483859][bookmark: _Toc1132547841][bookmark: _Toc219095912]Generalized epidemic, urban/rural template
In a generalized epidemic, when using the urban/rural structure, you define the number of the adult population in urban and rural areas by specifying the percentage of the population living in urban areas. If using the urban/rural structure, this is all you need to enter. The software already contains the United Nations Population Division values for each country; these are displayed when you first open this page. These proportions are updated to the latest United Nations Population Division urbanization projections available, which you can change to by clicking on “Adjust to UN values” in the lower left-hand corner of the interface. If you wish to change the urban percentages, you can fill the cells marked in blue. When done, click on “Save and continue” to store your results.
If you have changed the end year of your projection, you will need to identify the percent urban for the newly added years. This will be done automatically if you click on “Adjust to UN values”.
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[bookmark: _Toc1660260535][bookmark: _Toc1743603226][bookmark: _Toc219095913]Generalized epidemic, user-defined regions
If each subnational region has had many sentinel surveillance sites, and the regions differ in epidemic history, you can configure your national epidemic as a set of regional sub-populations. Provide the population for each region, in the table copied below. The bottom row shows total numbers of people aged 15-49 years, based on the UN Population Division Non-AIDS estimates. You must assign all this population across the different groups within the epidemic structure.
If you changed the end year of your projection, ensure the population distribution gets extended to all new years. 
After running the subnational curves in EPP, a corresponding national aggregated curve will be available in AIM. Additionally, the AIM Results menu shows sub-national results, under the item Sub-populations. (Note: Other indicators not shown in AIM by subpopulation you could allocate proportionally, based on prevalence or incidence.)

8.5 	For each region, enter the population for each year from 1970 to the end of the projection. Make sure the numbers for each year sum to the national total populations and that “Population still to assign” is zero for each column. When done entering all population data, click on “Save and continue”.
Tip: When you return to an existing Spectrum file and update the file with new demographic data, including overall population size, the population still to assign will no longer equal 0. To automatically adjust the population to the updated population figure, select Adjust for changed pop and EPP will apply the same annual regional distribution to the new population. Be sure the radio button is set to Populations. The adjustment will not work if set to Percent.

If you do not have populations for each year, but know the percentages of total population in each region in the start and end year, Spectrum can fill-in the table for you. To do this:
8.6	Change to percentages by selecting “Percent” next to the word “Display:” at the bottom left-hand side of the page.
8.7	Fill the percentages of the population in each region for the first year, 1970, in the table. Make sure that the percentages sum to 100%, so that “Population still to assign” is zero. 
8.8	Fill in the percentages for the final year in the final column in the table. These need not be the same percentages, as EPP will assume they grow or decrease according to the values you enter. Again, make sure that the percentages sum to 100% so that “Population still to assign” is zero. 
8.9	Click on the button “Calculate Proportional Values” and the software will fill in the additional entries for the entire table. 
Hit “Save and continue” to store your results and return to the AIM interface.

You can also use “Calculate Proportional Values” for the actual populations (instead of the percentages) if you have the total population in each region for the first year and final year. The procedure is the same: fill the table for the first and last years, making sure that “Population still to assign” is zero for both years. Then click on “Calculate Proportional Values”.
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[bookmark: _Toc219095914]Generalized epidemic, multiple subnational Spectrum files
As alternative to one Spectrum file configured by subnational region, you can create multiple independent Spectrum estimations, one for each region. Then aggregate those independent estimates to a national estimate, use the Spectrum Aggregate Tool (under Tools > More Tools > General > Aggregate). 
Use this option when there are many surveillance sites in each region and you have full demographic and epidemic information for each region: program data, subgroup size estimates and non-AIDS population data. This option produces full epidemic information (all indicators, with uncertainty ranges) for each region. 

[bookmark: _Toc219095915]Generalized epidemic, Naomi district estimates
All countries with a population-based survey that includes HIV prevalence values can produce subnational level estimates, no matter how their national Spectrum estimation was configured. The Naomi tool will allocate national estimates, from the national Spectrum file or from an aggregate of subnational files, into corresponding subnational level results. Indicators available from Naomi include HIV incidence, HIV prevalence, ART coverage, and their corresponding population values. These are produced for the current year and the year of the most recent survey. Targets are calculated for the next two years. 
See the Naomi model description at HIVtools.unaids.org under training materials at: https://HIVtools.unaids.org , under ‘HIV estimates and SI learning materials’.

[bookmark: _Toc192166037][bookmark: _Toc1842149581][bookmark: _Toc219095916]Concentrated epidemic
For concentrated epidemics each sub-population included will require the following data: HIV prevalence data, estimates of the number of persons in the sub-population, average time spent with the risk behavior for those sub-populations of persons with high-risk behavior. Do not create sub-populations for which no data are available. 
The Define Pops page allows you to define the size of each sub-population. Alternatively, the percent of the adult population in each sub-population can be provided. These values can change over time, if sufficient data are available to determine temporal changes.

8.5	Enter the estimated population size or the proportion of the adult (15-49) population in each sub-population by year (see 8.5 above for Generalized epidemic, User-defined regions for a description of the procedure).
	Key population size estimates in low or concentrated epidemics
The size of key populations entered to EPP should be based on estimates from the country. Guidelines on how to estimate the sizes of most at risk populations are available at https://www.unaids.org/sites/default/files/media_asset/2011_Estimating_Populations_en_0.pdf . For clients of sex workers – if included in EPP – consider using higher size estimates than those available from Demographic and Health Surveys or other population-based surveys. The West African Modes of Transmission project suggested estimates of client of sex workers above those surveys’ estimates, when combining estimated numbers of sex workers combined with number of clients reported by sex workers.
Consider applying a smaller percent of the population that are sex workers, clients of sex workers, MSM and/or PWID for the rural population than the urban population, if these behaviours are relatively rarer in the rural population. 
If you have no national or local size estimate for a key population, use the regional default estimate in Table 1 below.
Table 1: Population Proportions of Key Populations, by UNAIDS region
Data are based on country reporting to the Global AIDS Monitoring (GAM) system at UNAIDS, with assistance from other agencies. These data are reviewed and categorized by method used. The regional benchmarks below reflect estimates derived at national level with probabilistic methods between 2011 and 2024, also used in UNAIDS regional estimates of new adult infections among Key Populations in 2010 and 2023 (Korenromp-EL, Sabin-KM et al., J AIDS 2024). The process to assess methods is published in PLoS One 2016; 11(5): e0155150. The data are consistent with findings from similar exercises: Sexually Transmitted Infections 2006 Jun; 82(Suppl 3); Stevens-O et al. Population size, HIV prevalence, and antiretroviral therapy coverage among key populations in sub-Saharan Africa: collation and synthesis of survey data, 2010-23. Lancet Glob Health 2024, 12(9):e1400-e1412).
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	Sex workers
	Men who have sex with men
	Transgender women
	People who inject drugs

	Region
	Median
	Q1
	Q3
	Median
	Q1
	Q3
	Median
	Q1
	Q3
	Median
	Q1
	Q3

	Asia and Pacific
	0.28%
	0.21%
	0.57%
	0.91%
	0.78%
	1.60%
	0.18%
	0.07%
	0.37%
	0.14%
	0.03%
	0.31%

	Caribbean
	1.63%
	1.58%
	1.69%
	1.67%
	1.63%
	1.82%
	0.06%
	0.05%
	0.15%
	As Latin America

	Eastern Europe and Central Asia
	0.39%
	0.26%
	0.42%
	0.81%
	0.64%
	0.97%
	0.08%
	0.08%
	0.08%
	1.06%
	0.70%
	1.69%

	East and Southern Africa
	0.79%
	0.52%
	0.93%
	0.73%
	0.58%
	0.86%
	0.21%
	0.12%
	0.25%
	0.20%
	0.11%
	0.66%

	Latin America
	0.53%
	0.33%
	0.83%
	1.73%
	1.23%
	1.80%
	0.10%
	0.10%
	0.18%
	0.21%
	0.21%*
	0.21%**

	Middle East and North Africa
	0.37%
	0.31%
	0.60%
	0.68%
	0.49%
	0.79%
	0.13%
	
	
	0.23%
	0.12%
	0.34%

	West and Central Africa
	0.55%
	0.49%
	0.70%
	0.38%
	0.15%
	0.39%
	0.04%
	0.03%
	0.07%
	0.16%
	0.09%
	0.23%

	North America
	As Western and Central Europe
	2.68%
	2.59%
	2.77%
	0.61%
	0.60%
	0.63%
	0.57%
	0.57%*
	0.57%**

	Western and Central Europe
	0.29%
	0.26%
	0.53%
	2.06%
	1.46%
	2.52%
	0.26%
	0.26%*
	0.26%**
	0.51%
	0.46%
	0.63%



Values marked with * refer to the minimum and those with ** refer to the maximum, instead of quartiles as in the other cells.
Population size estimates are typically reported as a number after an empirical measurement exercise. For averaging and extrapolation to other countries, we converted these to population proportions, out of adult men and women 15-49 years. This standardization also ensures that in EPP, numbers will change in proportion with each country’s population growth. Data included are national adequate size estimates (https://journals.plos.org/plosone/article/authors?id=10.1371/journal.pone.0155150 ), from: 
· South Africa: estimates compiled by Johnson-L & Dorrington-RE 2018; 
· Rest of sub-Saharan Africa: estimates based on a systematic review of published and GAM-reported PSEs, by Stevens-O et al. https://www.medrxiv.org/content/10.1101/2022.07.27.22278071v2 ; 
· Eastern Europe & Central Asia: estimates used in national epidemic Optima model calibrations produced over 2022-2024; 
· Asia & Pacific: estimates used in country-owned 2025 Spectrum calibrations of AEM or (if no AEM) 2025 Spectrum EPP-Concentrated. PSEs used in EPP were accepted only if above the country’s report into GAM (if applicable) or else if above the GAM 2025 regional median PSE. 
· Other countries and populations: country reports into Global AIDS Monitoring for data years 2011-2024. In contrast to 2023-round definitions of nationally adequate, no minimum threshold was applied for the percentage of men who are MSM; 
· Remaining countries and populations: regional median of available country estimates. 
Concentrated epidemic configurations additionally require information on the proportion of the sub-population that is male and the average duration an individual stays in the sub-population. The latter is used to calculate the rate of turnover across sub-populations. This information is asked on the second tab of the define populations page titled “% Male and Turnover” in the concentrated epidemic template. 
8.6 	Indicate whether people are likely to move in and out of this sub-population. If there is evidence of turnover from these groups (i.e. that sex workers move in and out of the sex work occupation) you should activate the “Turnover” button. In contrast, remaining men and women populations by definition have no turnover. 
8.7	Enter the estimated time (in years) that a person spends in that sub-population. This is used to determine the rate at which new members enter and old members leave the population. For example, if it is set to 5 years, then 1/5 of the population changes every year, i.e., 20% of older members are replaced by newer ones. Sex workers in most countries are known to have a short average duration (few years). 
8.8	If turnover is selected you need to specify where the given at-risk sub-population member will go after leaving this population. Under “assign prevalence to” select the sub-population they will enter, normally the male or female remaining population.
8.9	You also need to determine whether to add the prevalence of each sub-population to the overall prevalence or to replace it. Choose “add prevalence” to add those who are HIV positive from the former at-risk group members to the HIV positive members of the target population – this is recommended if these persons are not likely to be captured in routine HIV surveillance. Conversely, “Replace prevalence” if a sample of people who acquired HIV while being in a higher-risk group will be seen in ongoing surveillance after moving to a lower-risk group.  Examples are given in the box below.
Hit “Save and continue” to store your results and return to the AIM interface.
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	Add or replace sub-population prevalence in concentrated epidemics?
	Replacing prevalence: Suppose a country has former sex workers, who when pregnant attend ANC and receive HIV testing. If EPP fits HIV prevalence among ‘Remaining Women’ to ANC prevalence data, some of this prevalence will derive from former sex workers who acquired HIV while selling sex; some proportion of HIV is attributable other modes of transmission, e.g., from intimate, steady partner during heterosexual sex. Therefore, the HIV infections among former sex workers should replace some of the prevalence detected in ANC women, to avoid double-counting. This ‘turnover’ between female sex workers and ANC women does not increase the overall prevalence rate among ANC women, but it means that less transmission occurred through other routes of transmission. 
	Adding prevalence: On the other hand, men who injected drugs and then stopped, or former male clients of female sex workers are unlikely to be detected after quitting drug use or buying sex, absent routine surveillance in non-key population men, which is rare in concentrated epidemic settings. Their infections are therefore unlikely to be detected in routine surveillance. There is little chance of double counting so EPP needs to add these infections among people who formerly injected drugs to its total prevalence estimate among men. 
Estimates of time in most at risk populations, by region
Average duration of female sex work, by region
	Region	Duration of behaviour, in years	
	Africa	5.5 (4 studies)
	Asia/Oceania	2.9 (12 studies)
	North America 	10.2 to 11.0 (3 studies)
	Europe	8.4 to 10.0 (10 studies)
	Latin America	11.2 to 12.0 (6 studies)	

Average duration of injecting drug use, by region
	Region	Duration of behaviour, in years	
	Africa	5.6 (1 study)
	Asia	8.7 (6 studies)
	Oceania	17 (1 study)
	Europe	13.9 (1 study)
	North America	9.5 (1 study)
	South America	21 or 19.6 (9 studies)	

Source: Fazito E, Cuchi P, Mahy M, Brown T. Analysis of duration of risk behavior for key populations: a literature review. Sex Transm Infec 2012;88:i24-I32. doi:10.1136/sextrans-2012-050647




[bookmark: _Toc474851178][bookmark: _Toc57632944][bookmark: _Toc1560916262][bookmark: _Toc1675212425][bookmark: _Toc219095917]Step 9.	EPP Incidence: Enter surveillance, survey and ART distribution data
Once the epidemic structure and populations have been defined, enter the available HIV prevalence and incidence data. From the AIM menu, choose: Incidence > Surveillance Data (EPP). This will take you to the Surveillance Data pages, with a separate data entry tab for each sub-population. 
[bookmark: _Toc2126805414][bookmark: _Toc134546930][bookmark: _Toc219095918]HIV prevalence surveillance data
The first step on the HIV Surveillance data page is to identify what sort of prevalence data are being entered, at the bottom of the page: 
The “HIV Data Type” selection radio buttons on the lower left specify whether the data presented on this page is for ANC based samples (“ANC”) or from HIV sentinel surveillance (“HSS”), such as surveys among key populations. If “ANC” is selected, you can enter both ANC sentinel surveillance (ANC-SS) data and ANC routine testing (ANC-RT) data for sites. If ONLY routine data for ANC are available (e.g., the summed value of all ANC routine testing in the country as in some Eastern European countries) then the HSS setting MUST be used with the data entered as a single site, otherwise EPP may not be able to fit the data.
The “ANC-RT, ANC-SS, Both” selection radio buttons are on the right. If the “HIV Data Type” button on the left is set to “ANC”, the button on the right controls whether ANC-RT data, ANC-SS data or both types of data are displayed in the table (see below for an example). If the “HIV Data Type” is “HSS”, then these are grayed out and there will only be one type of HIV data displayed in the table. 
If you have ANC-RT data to enter, set the “HIV Data Type” to “ANC”. The table will then change to the following format:

 [image: ]

If you select ANC data, each site (green box in the figure) now has four lines (SS % and N, and RT % and N), instead of two (% and N). The first two lines (label “SS”) are where you can enter ANC sentinel surveillance data (prevalence and samples size for that site). The next two lines (label “RT”) are where you enter ANC routine testing data (prevalence and sample size) for the specific site. 
The line at the top (“Census level”) is to enter the overall routine testing prevalence and total number of women routinely tested (within and outside of sentinel sites) within the region being modeled. If you check the box in the first column, the census level data will be used in the fitting; otherwise, the census-level data will be ignored. 
These values can be cut and pasted into the HIV Data Page from Excel, using standard copy and paste functions, e.g. CTRL-C and CTRL-V.
The “Mean/Median” button at the bottom of the page controls the display of rows showing means and medians. If clicked once, the screen will appear as below, with means and medians (across active sites only) displayed at the top of the page. Click it again and those rows are hidden.
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NOTE: When entering routine testing (ANC-RT) data, keep the following considerations in mind:
For both ANC-RT site data and ANC census-level data, the denominators (N) and prevalence entered should be based on all women attending the clinics for antenatal care. If some attendees are not tested (e.g., if women are already known to be positive and therefore are not retested), the prevalence entered should be based on the sum of women newly diagnosed and those known to be positive, divided by the number of women attending for antenatal care and either tested or already known to be HIV positive, according to the following formula: 
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Known positives that are not re-tested should be added to both the numerator and denominator for all routine program testing data, including key populations. If your country stopped sentinel surveillance (in ANC and key populations) and relies on routine programmatic testing results as a proxy of prevalence, adding the known positives is imperative to prevent mis-interpreting a typical decline in programmatic positivity rates. Improving knowledge of serostatus and decreasing prevalence of undiagnosed infection would otherwise be misinterpreted as a decline in population-based prevalence. So, without this adjustment, the EPP prevalence curve would decline too quickly in recent years. 
For ANC, it is possible to enter ANC-SS, or ANC-RT or both, for any given site in any year. Any overlap (as in in 2012 and 2014 in the above example) will help EPP establish the relationship between ANC-SS and ANC-RT trends. 
For ANC, remember that in the first few years, the number of routine testing samples may have expanded quickly as testing was scaled up and the system expanded to reach women in areas not previously covered by testing. The quality of the data may also have progressively improved as the reporting system got stronger. These factors may influence the prevalence measured, e.g., as the system expands into lower prevalence areas or the testing algorithms improve to better exclude false positives. To best inform the fit, do not enter routine data into EPP until the years when the routine testing system has stabilized and sample sizes are fairly consistent from year to year. Using data from the initial scale-up period may produce spurious trends in the prevalence data. See the ANC testing review page under Program Statistics to check this. 
In assessing the quality of routine ANC testing data and whether or not to use it in fitting, also review: any recent data quality assessments , known weaknesses in test results (e.g., false positives), the testing algorithm and how it may have changed in recent years, whether the reporting of routine testing results is timely and complete, whether any test stock-outs may have led to incomplete testing or preferential testing of only highest-risk women, test refusal rates and proportions of attendees not tested for any reason, and lastly the timing of testing within the pregnancy (ideally, data entered into EPP should be from the first ANC visit only – excluding repeat tests later in pregnancy).

Checklist before using HIV prevalence data from routine testing 
Review the routine ANC prevalence data before using the results in EPP.  If any of the following criteria cannot be met, then we recommend that the data should not be used.
1. Are there sharp increases or decreases in prevalence trends? 
In a stable population prevalence should be flat over a short period of time.
2. The routine data must include women already known to be living with HIV and women newly diagnosed.  The prevalence entered should be calculated as (women who tested HIV positive + known positives) / (all women tested for HIV + known positives + (if applicable) known negatives). The sample size entered on the second line should be (women tested for HIV + known positives +, if applicable, known negatives).
3. Determine whether the ANC data available are timely and complete.
4. Ensure that only the first HIV test during a pregnancy is included in the analysis. If women are tested multiple times during the pregnancy the later tests must be removed from the prevalence rate and the sample size entered in EPP.
5. Consider whether there could be weaknesses in the test results (i.e. false positives).
6. Identify the testing algorithm used for diagnosis at facilities and whether that algorithm (and test kits procured) has changed over the past three years and might mean the trends are not comparable. Review any quality assurance efforts or programmes to identify testing errors.
7. Include all first tests during a pregnancy even if that first test occurs during labor and delivery. This will reduce bias of women who do not attend antenatal care. 
8. Determine whether there have been any testing stock-outs that have required rationing of tests at the facility level. (Testing may be done on the riskiest women only)
9. Look at rates of refusals and proportions of attendees not tested compared to number of expected births.
10. Finally, review household survey data on the percent of women not attending ANC and the characteristics of those women to understand biases. Compare prevalence among pregnant women in the survey to the census-level prevalence.

The specific steps for entering sentinel surveillance and routine testing data are:
9.1a 	Count the number of sites with data for the sub-population. Add rows on the data entry page by clicking on “Add sites” so that there is one set of rows per site. (For each site there is a row for the prevalence and a row for the sample size.) You can also add many sites at a time using “Add Multiple” and entering the number of sites to be added. 
9.1b	Enter the surveillance data: If the data are already available in a spreadsheet format it is easy to copy and paste the data into the worksheet. Copy and paste the site names into the far-left column. Copy and paste the data into the page for that sub-population (e.g. for urban sites or for sex workers). When pasting the data, be sure that the years align correctly.
9.1c	Press “Save and continue”. If you forget this step, you will lose the data that you have pasted into the page! Enter the data for all remaining sub-populations using the same steps as above. After you have saved the data for the last sub-population, you will be automatically taken to the Surveys tab.
Tip: If the sample sizes for each site are not available change the “Display” variable to be “% HIV”. This will allow you to copy and paste just the prevalence information by site into the worksheet. A default size of 300 will be assigned to each site in this case.
Tip: Prevalence estimates should be entered as whole numbers, not as percentages (e.g., a prevalence of 12% should be entered as 12, not as 0.12).
Tip: Be sure the boxes on the left corner are ticked. If they are not ticked, the site will not be included in the fitting of the model.
Tip: if you do not enter sample sizes, you will receive a message when you click “Save and continue” that will inform you that all sample sizes are being set to a default of 300.
Tip: If the prevalence for a site is 0% and this is an actual measured value (not one created to anchor the early prevalence), then leave it in the data set along with its sample size.
Tip: if you get a warning that the prevalence is too low for the sample size, you have entered a prevalence value that could not be determined from a set of measurements with the sample size you provided. Please use a larger sample size that reflects the actual origin of the prevalence value. For example, one could not determine a prevalence of 0.5% with a sample of 100 as this would imply that only one-half a person was living with HIV.
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[bookmark: _Toc270964998][bookmark: _Toc253560814][bookmark: _Toc219095919]Surveys of adult prevalence, incidence and ART coverage
If your country has collected adult HIV prevalence, incidence or ART coverage in one or more national population-based surveys or incidence through cohort studies, you can add those data on the Surveys page to inform EPP’s curve fitting. Surveys with results in the public domain (such as DHS and PHIAs) can be automatically imported, by selecting the “Import surveys” button. For surveys that were not available in the public domain, you can enter the data by clicking on “Add another survey”. If using a previous year’s file most of this information will already be entered, but you should review it for completeness and enter any new surveys that have become available since the last round of estimates.
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If the same survey measured both prevalence and incidence, enter the point estimate and corresponding Standard Error (SE) for both indicators, and in the Incidence row, also enter the correlation between prevalence and incidence in this survey. Prevalence and incidence estimates collected from the same survey are correlated, because (1) the formula for estimating incidence from recent infection relies on prevalence as one of its inputs, and (2) correlation may arise from the clustered sampling structure of household surveys. 
The incidence calculator at https://worldhealthorg.shinyapps.io/recency_incidence_calculator/ provides a tool to input summary data from household surveys and generate estimates of prevalence, incidence and the correlation. If it is not possible to estimate the correlation to input in EPP, leave the Corr field empty, and EPP will itself estimate the correlation assuming that prevalence and the proportion of recent infections are uncorrelated, as would be the case for data generated from simple random sampling. If the incidence estimate came from a prospective cohort and you leave the Corr field blank, EPP will assume 0 correlation.
If the survey collected only prevalence or incidence, enter the measured value(s) and the standard error(s). If incidence came from a prospective cohort, instead of a recent infection testing algorithm ("incidence assay") in a cross-sectional survey, check the box in the final column. In this case enter the baseline year of the cohort survey as the Year.
On the same page, you can enter adult ART coverage if this was also measured in the representative household surveys. As with HIV prevalence and incidence, the entry should be for the 15 to 49 population. Inputs consist of the point estimate for coverage as a percent of PLHIV and the corresponding standard error. The Surveys database in EPP has been updated to include any survey ART coverage data publicly available to UNAIDS, mostly from Population HIV Impact Assessment surveys (PHIAs). 
When you click “Import surveys “, all 3 indicators can be filled at once from the database. If survey HIV prevalence, incidence or ART survey data had already been entered or imported into your EPP file, EPP will give a pop-up as shown in the figure below. This indicates where surveys from the database have already been entered on the EPP Surveys Page. You are then given five options:
· “Append to Existing” – all surveys from the database will be added to the set already on the Surveys Page. This will rarely be used as it will create duplicates, which the user will need to sort through carefully, deciding which of the duplicates to keep.
· “Replace All” – the existing survey data in EPP will be entirely deleted and replaced by the survey data coming in from the database.
· “Update matching” – EPP will update those surveys where there is name and year match with the values from the database. Only use this if you believe the values from the database are preferable to the ones already entered.
· “Update only ART” – only the ART survey values for each survey will be updated. The prevalence and incidence for each survey will be left as it is.
· “Cancel” – exit without making any changes.
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If you do not want EPP to use prevalence, incidence or ART coverage from a particular survey in fitting, uncheck the boxes “Use prevalence in fitting”, “Use incidence in fitting” or “Use ART in fitting”. As default, the “Use ART” box is checked i.e. activated, when you import ART survey data.
If your country does not have HIV prevalence, incidence or ART coverage data that is representative of the population being modeled, do not add any surveys for that population. 

[bookmark: _Toc1566865641][bookmark: _Toc1625886681][bookmark: _Toc219095920]ART distribution: allocation to EPP’s sub-regions or sub-populations
Spectrum-AIM passes to EPP the reduction in HIV transmission when a person is on ART, by a default of 80%. To accurately represent the impact of ART on incidence within each sub-region or sub-population fitted, EPP must know their respective trends in numbers on ART.  
EPP allocates national ART numbers, obtained from AIM-> Program Statistics->Adult ART entries, across its sub-regions or sub-populations through one of the following three options:
· If a national household survey provides both ART coverage and HIV prevalence across all sub-regions or sub-populations, EPP uses “ART coverage * HIV prevalence * 15-49 pop” to calculate the proportion on ART in each region, for the survey year(s).
· If national household serosurvey data are available in several years in all sub-regions or sub-populations but without ART coverage, EPP uses “HIV prevalence * 15-49 pop” in those years to calculate the burden of PLHIV in each region, and it allocates ART proportionally.
· Otherwise (if there is no relevant survey data), EPP falls back to allocating ART according to the mean prevalence in site-level surveillance data (ANC for generalized epidemics; any populations entered in site-level sentinel surveillance for each subpopulation in concentrated epidemics), multiplied with each sub-population’s or sub-region’s 15-49 population in 2010. Again, this serves as a proxy for HIV burden, which is then used to apportion ART.
EPP then applies these proportions uniformly across all years to estimate the number on ART in each region or sub-population in each year. 
The apportioned ART values are shown for the user’s review on the ART Distribution page, located immediately after the Surveys page. The default apportionment will be shown as blue colored cells. If desired and if program data are available on the actual distribution of ART among regions or sub-populations, you can edit these distributions here. When the user edits the value, the cells will turn yellow, making it easy to see where users have made changes. For some countries, the number on ART is available for some recent years from Naomi district-level estimates. Naomi estimates have been entered in a built-in EPP database (ARTDist_db.CSV). You can access these through the “Import Naomi” button. When you import Naomi data it will show up in a bright blue, cyan, color. If the Naomi ART sums in any year disagree with the ART values from Spectrum, the user will be offered the opportunity to scale them. Any years which need to be scaled to match Spectrum will be colored yellow (i.e., the user made a change in them), while Naomi values which did not change will still be in cyan-colored cells. After reviewing the ART Distribution table and making any desired changes, click on “Save and continue” so that this information is recorded by EPP and used in fitting.
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In some countries a substantial number of new infections are among people who contract HIV while abroad. In others, new infections occur in medical or hospital settings. If there are data on numbers of such infection ‘surges’ by subpopulation and calendar year, this window provides a way to add these people to EPP’s adult PLIHV estimate. See text in the screenshot for more information.
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[bookmark: _Toc474851179][bookmark: _Toc57632945][bookmark: _Toc936471053][bookmark: _Toc953439565][bookmark: _Toc219095922]Step 10.	EPP Incidence Curve fitting 
[bookmark: _Toc2098704010][bookmark: _Toc1133294489][bookmark: _Toc219095923]EPP curve fitting – Project trends
Under EPP Curve fitting, on the Project page, the data entered in the previous pages are used to create an HIV epidemic curve and to analyze the uncertainty around that curve. There are four statistical models that EPP can use for curve fitting:
R-Hybrid: This is the best model for most EPP datasets and sub-populations or areas, combining a more structured model from epidemic start until the early 2000s, when data were sparse, with a more flexible model that allows infection rates to fluctuate, from 2005 onwards as increasing data are available to inform recent trends. 
R-Spline: This model allows considerable fluctuation, but typically estimates the recent prevalence to be flat. 
R-Trend: This model is useful for geographic areas with many years (8+) of surveillance data and many (7+) surveillance sites. 
EPP Classic. This model should be used for geographic areas with few data points. However, if 1) EPP-Classic gives an initial prevalence rise that is too sharp and implies an implausibly early and sharp incidence peak, and 2) the data show a consistent time trend that could be cleanly fit with a single curve, you may consider another model such as R-Hybrid, R-Spline or R-Trend. Prior to doing this, consult with UNAIDS, as it is possible the model may overfit the data if there are too few data points. 
 
If a country with EPP configured as a generalized epidemic has some areas with five or more years of surveillance data (high-data-quality) and others with less than five years of surveillance data (low-data-quality), we recommend running a hierarchical model to help inform the low data quality area to improve the accuracy. See Annex 5, available from UNAIDS upon request. 
10.1	Select the most appropriate statistical model in the upper left portion of the screen, using the decision tree in Figure 1. 
10.2	If you are running the model as an exercise, click the “Training” button under “Purpose of run”, so that only 400 unique curves will be calculated. To run the model as your final country estimation, instead click “National projection”, which increases the number of unique curves to 1000 for R-Hybrid (or 1,900 for R-Trend and R-Spline). This number of curves will take much longer to run. To interpret any results, run as a “National projection”; training fits may fluctuate greatly and may not always settle into the best fit to available data. 
10.3	To produce the HIV incidence curve for the subpopulation selected, click the green ‘Fit’ button. To run the curves for all sub-populations in turn, click ‘Fit all’ after selecting each sub-population in the list of sub-populations on the right and choosing the statistical model to be used for each one.
10.4	Review the curve. The median curve will show as a red line, and the 95% confidence intervals will show as blue dashed lines. Make sure the start year of the epidemic reflects the best understanding of the HIV epidemic in your country. This is especially important if you are using EPP classic or R-Trend. 
Note: If ANC-routine testing data are entered, these appear on the Project Page as purple dots, while the ANC-SS data appear in green. ANC census data show up as a dark purple series. The ANC-RT data also appear on the Fitting Results page, as a series of connected data points, if you have chosen to display “Surveillance data”:
10.5	Once you are satisfied with the fit, choose “Save and continue” and move on to fitting a curve for the next sub-population. If you used ‘Fit all’, you may wish to click ‘Save all’ once all the fits are complete so EPP will save each fitted projection as it goes through each sub-curve. Alternatively, you can click ‘Save and continue’ for each one, but be sure to do so for all fitted projections in turn, or you may lose some of your fits.
10.6	If you are not satisfied with a curve, use the model parameters tab in the lower left of the interface to constrain the curves (see the box titled “Setting restrictions on prevalence curves”). For example, if there is little data early in the epidemic, the model will often allow curves to grow very quickly at start of the epidemic. This can be constrained by limiting the prevalence in 1980 to <1% or some other appropriate maximum. 

	Setting restrictions on prevalence curves
In some instances, where there is limited data, the models will find curves that are not realistic given what is known about the epidemic in your country. If the model produces curves that are not realistic, constraints should be placed on the curves using the Model parameters tab. Under this tab, you can: a) alter the range of possible start years to be more realistic for your country; and 2) apply conditions on prevalence that allow you to eliminate epidemiologically unrealistic sets of curves. These constraints on start years and prevalence should be used sparingly and with careful consideration of the following guidance:
1. Before making prevalence conditions, make sure the start year covers the full range of possible start years (a range of about 15-20 years). Normally, they should start up to 5 years before the first detection of local transmission of HIV or AIDS in your country and run until about 5 years after the first non-zero data point. This will give the models the flexibility they need to consider all possibilities. NOTE: this applies to R-Trend and EPP Classic, but not to R-Hybrid and R-Spline where the start year is set in a country-specific way.
2. Also, before applying any prevalence conditions, run the model without any constraints. Then carefully examine the results to determine if there are curves which are absolutely outside the realm of possibilities given your data.
3. Limit the number of prevalence conditions to the minimum number needed to eliminate unrealistic curves. If you apply too many constraints, you may eliminate curves that are legitimate fits to the data given its statistical uncertainties.
4. Do not set lower constraints and higher constraints in the same year. This will artificially restrict uncertainty in your curves and they will not reflect the true uncertainty in your data.
5. Avoid setting restraints close to years in which data are available (within 3-5 years) if possible. Use them optionally and only to reflect knowledge of allowable prevalence for early stages of the epidemic when data was less available or to eliminate unrealistically high curves, e.g., 80-90% prevalence or 5 to 10 times the peak prevalence in the EPP fit during the years with data.
6. Look at the resulting fit (red line with crosses) relative to the data, to decide if the fit is reasonable and not necessarily the full range of possible curves (gray) some of which may be very high or low in future years. These high or low future values may reflect the true uncertainty in your epidemic’s future when data is sparse. 
Other EPP model parameters:
i. Ro is the growth parameter determining pace 
ii. Iota is the magnitude of the initial pulse that kicks off the epidemic; higher is larger initial peak. Some countries may want or need to reduce this below the default of 0.0025 (e.g. to 0.00005) notably for remaining (lower risk) populations. R0 is the growth of the epidemic following the (iota-based) initial pulse; a low R0 (e.g. 10, below the default of 150) keeps it from growing too fast, which is sometimes needed to obtain realistic early epidemic patterns for remaining populations, or even sometimes for key populations.
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For generalized epidemic countries which use the Urban/Rural configuration or the same sub-national structure as in the previous estimates round, an age-structured version of EPP (with R-Hybrid, R-Spline or R-Trend) is recommended. This takes the age-sex structure from the preceding Spectrum estimate and applies it to align EPP’s new calculations with the country’s age-sex structure. Use of the age-structured model is activated under “Model Parameters” on the Project Page, checking the box near the bottom of the panel labeled “Use age-sex model” (ASM). If R-Hybrid is selected, the age-sex structured model will be used by default, but the age-sex structure must be explicitly selected for the R-Spline or R-Trend models. 
If your EPP Configuration is not a generalized epidemic or not based on the Urban/Rural template or an existing sub-national region, this button is grayed out and the age-sex structured model not available.
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Besides activating the ASM model when possible, countries using EPP’s Generalized epidemic configuration should also ‘’Use ANC adjustment’’, under Model parameters (see Figure below).  This ensures that EPP accounts optimally for differences in prevalence between ANC and overall adult populations, including their variation over time and between settings. Multiple factors produce these differences, notably: 1) different age distributions of pregnant women attending ANC clinics versus the adult population at large; 2) different age distributions between men and women living with HIV; 3) lower fertility among women living with HIV, especially in later stages of infection and if untreated; 4) ART coverage differing between pregnant women and other adults. 
The age-sex structured model (ASM) adjusts for these factors automatically in its fitting of overall adult prevalence. If using ASM and “Use ANC adjustment”, EPP fits the model prevalence among pregnant women against ANC data, and national adult prevalence against national household surveys. With the ANC adjustment turned-off, in contrast, EPP-ASM fits overall adult prevalence on surveys and ANC data, but not produce an estimate for pregnant women.
If not using the ASM, EPP in the Generalized configuration will instead do the ANC adjustment, if activated, by applying a country- and time-specific ratio in prevalence between pregnant women and all adults. These ratios then derive from the country’s previous year’s national AIM projection. 
For countries using the ANC adjustment, a green line labelled 'ANC Prev' on EPP curve fitting graphs shows the prevalence among pregnant women. No green line will appear if the ANC adjustment is not used.
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[bookmark: _Toc31715236][bookmark: _Toc551745143][bookmark: _Toc219095924]Calibration - Generalized epidemics
EPP calibrates its prevalence to survey data, if entered on the Surveys page. The resulting fit is typically a good balance between the surveys and surveillance data. The fitted curve will not always pass exactly through each survey point(s). This is not a concern; however, after curve fitting, you can choose to scale the EPP curve to pass through the latest survey point exactly, on the Calibration Page. 
Generalized epidemic countries can calibrate to their latest national survey entered in EPP. If you have not had a national population-based survey, then leave the default setting: “Use the modeling results as they are”. This has already shifted urban and rural prevalence based on regional averages from numerous other countries with surveys. 
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[bookmark: _Toc1490022416][bookmark: _Toc274633846][bookmark: _Toc219095925]Calibration - Concentrated epidemics
For concentrated epidemic countries, generally without a national household serosurvey, the Calibration page gives the option of specifying, for each sub-population, either an expected prevalence in a specific year or a scale factor to scale the entire prevalence curve up or down across all years. 
To apply calibrations:
10.7 Select the sub-population you wish to scale in the list of sub-populations shown 
10.8	Select one of the options
	Use the modeling results are they are. This option keeps the calibration that was established during the fitting.
	Adjust HIV prevalence to a user specified value. This calibrates the best fit curve by multiplying all prevalence values by a constant number which ensures that the adjusted best fit curve goes through a user-specified prevalence value in a user-specified year. This might be the value from a more representative sample of the specific surveillance population, e.g., an IBBS study of female sex workers.
	Scale the results up and down by a factor. Choosing this option scales all prevalence by the user-provided provided number. For example, if you enter 0.5, it gives a prevalence curve with each value cut in half.
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For concentrated epidemics, a Calibration Table is available, through the button in the lower right-hand side of the Calibration page. This table shows the number of people living with HIV in all sub-populations after calibrations are applied. You can also enter national estimates of prevalence among those 15 to 49 years old on the right-hand side of the page for different years and the corresponding number of people living with HIV in that year will be shown in the 3rd line from the bottom labeled ‘Survey-based HIV+ (#)’. You can compare this against the numbers of people living with HIV after your calibrations are applied. The final row of the table shows the female-to-male prevalence ratio, to ensure that the calibrated curves produce an appropriate proportion of female and male infections, matching country data if available. This table is dynamic: when you change calibrations on the Calibration page, the table will adjust.
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	Calibrating prevalence for the “remaining men or women (low-risk) populations” – Concentrated epidemics
ANC surveillance data can be used to estimate prevalence for the remaining women, using an adjustment reflecting that women attending ANC typically have higher HIV prevalence, because of biases in the geographic selection of antenatal clinics in sentinel surveillance and in the age of ANC women versus women in the general population. Comparing prevalence data between ANC and population-based surveys in several low-level epidemic countries (or states) showed that on average HIV prevalence among all women was 47 percent that measured in ANC. Thus, a down-scaling adjustment for women in the remaining population of 0.47 is recommended after fitting ANC data. The option “Scale HIV by factor of” should be chosen and 0.47 entered.
For men a similar analysis showed that HIV prevalence in the remaining men averages 56 percent of ANC prevalence. As a result, the adjustment from ANC data to men in the general population should be 0.56. These recommended calibration factors were based on a small number of countries. 
All countries that have one or more representative population-based serosurvey should use the survey-based prevalence, entered separately for men and women, to calibrate the EPP estimate for remaining men and women in the general population, in turn.
Similarly, if there are prevalence data on men from a universal service, such as mandatory military service, if it is not restricted to a specific age group and not correlated with an increased risk of HIV, these data can also be used (as EPP fitting data in Surveillance > Surveys, or for EPP’s post-curve fitting Calibration)to inform prevalence among remaining men.



[bookmark: _Toc1191136170][bookmark: _Toc1637512701][bookmark: _Toc219095926]Review Fitting results in EPP
Once completed you should click on ‘Save and continue’ to move to Fitting Results. On this page you can review the resulting prevalence trends, by population type and as a national total that combines the trends of all sub-populations. Select the population(s) you want to examine from the list at the top right of the page. 
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You may also compare your new results with those from a previous projection by clicking the ‘Compare’ button. That will display a screen like the one shown below. Click the ‘Load’ button and select the comparison projection’s Spectrum (*.SPT) file or the previous projection file (*.PJNZ) which contains the previous projection. Then the charts will compare your new projection (red) with the previous projection (blue) for prevalence, incidence and population size. This screen also shows the female to male ratio of HIV prevalence, for concentrated epidemics. This is left blank for generalized epidemics, where female to male ratios are calculated within Spectrum). When you have finished viewing this page, close it by clicking ‘X’ in the top right of the window.

[image: ] 

Some countries with program-reported number of AIDS and HIV cases (prevalent or incident) can enter these and compare them with EPP-estimated AIDS deaths or prevalent or incident infections over time. Select this EPP option by clicking the ‘Data Check’ button. This will bring up the display shown below: 
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To facilitate comparing the time trend between case or death reports and EPP-estimated HIV infections or AIDS deaths, you can ‘’Normalize’’ the lines to show both on the same scale, by scaling-up the reported AIDS cases to match estimated deaths. To do so, enter start and end years below the graph and check the box marked “Normalize”. The graphs below show the effect: left-hand is before, and right-hand after normalization to common (notional) y-axis scale. 
These comparisons are useful to check EPP’s trend estimate for early years of the epidemic, when prevalence data to guide EPP’s trend were scarce. The normalization period should be the years for which notification data in the WHO database (or entered by the user) are reasonably consistent and accurately reflect the real time trend, allowing for a time-constant level of underreporting but without shifting completeness and biases. Often, the initial years of a country’s epidemic were badly underreported, until AIDS reporting was expanded to the entire medical system. Conversely, the years end-1990s saw weakening AIDS case reporting, and with ART roll-out an AIDS diagnosis no longer predicted death within typically one year, so the comparison of EPP-estimated deaths against AIDS diagnoses is less insightful. 
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Once you have finished viewing the results, click ‘Save and continue’ to move to the next step. 

[bookmark: _Toc219095927]Reassigns – concentrated epidemics
The Reassigns window provides a means to examine the effect of Turnover (specified in EPP’s Configuration window) on the distribution of PLHIV to subpopulations in concentrated epidemics. This is an important tool for analyzing the estimated source of HIV infections. Notably, some “Remaining males” and “Remaining females” probably contracted HIV while being part of a higher-risk subpopulation earlier in their lives, rather than through ostensibly low risk heterosexual intercourse.
In the example below, in 2013, there were 3780 PLHIV in the “Remaining male” population. In that year, 2542 former PWID living with HIV were reassigned, that is added, to “Remaining males” because they had spent the full time allotted, for example, 10 years, in the PWID population. As specified in the Configuration page, EPP assumes that those PWID who are still alive after 10 years stop injecting drugs and become part of the “Remaining male” population. Another 1239 men in the “Remaining male” population became infected while already part of the “Remaining male” subpopulation, via another route, presumably heterosexually.
Similarly, female sex workers who retire from sex work after their “turnover time” are reassigned to the “Remaining female” population (502 women in 2013.) In EPP these women effectively replace other women living with HIV in the “Remaining female” population based on EPP’s estimate fitted to prevalence in antenatal clinics. Women infected with HIV via other routes totaled 1271 in year 2013 in this example, so that the total HIV infections among “Remaining females” matches prevalence measured and fitted to ANC data. 
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[bookmark: _Toc474851180][bookmark: _Toc57632946][bookmark: _Toc194299601][bookmark: _Toc1556725829][bookmark: _Toc219095928]Step 11.	Case surveillance and vital registration (CSAVR) incidence fitting tool
For countries with strong vital registration and HIV case reporting systems and sparse or inconsistent surveillance data, estimating incidence curves based on HIV case surveillance and vital registration (death) data may be the most suitable modelling approach.  The Case Surveillance and Vital Registration (CSAVR) model provides this option.
Possible CSAVR inputs are: 
New, first-time HIV diagnoses; 
· AIDS-related deaths from vital registration systems; 
· New HIV diagnoses by CD4 cell count category; 

All three inputs pertain to adults 15 years and older. New diagnoses or AIDS-related deaths at ages 0-14 years should not be entered. New HIV diagnoses and AIDS-related deaths can be entered either as aggregate totals, or disaggregated by sex, or disaggregated by sex and five-year age group.

[bookmark: _Toc1969346767][bookmark: _Toc974488880][bookmark: _Toc219095929]Select the CSAVR incidence fitting option
To enable CSAVR as the incidence model for your projection, select Incidence options from the Incidence menu in AIM. Next, select Case Surveillance and Vital Registration (CSAVR) from the incidence fitting methodology drop-down menu. This enables the menu items described below.
The first step in fitting incidence through CSAVR is to update the case surveillance and vital registration data. In the Incidence menu in AIM, select Fit incidence with CSAVR, then select Enter/edit data. This will open a data entry form:
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[bookmark: _Toc654233517][bookmark: _Toc763790144]
[bookmark: _Toc219095930]Enter New case diagnoses data for CSAVR to fit
New case diagnoses are defined as the first report of infection to the national surveillance system, whether HIV or clinical AIDS. Enter all first-time diagnoses, each once, among long-term residents, immigrants living with HIV and individuals returning home having acquired HIV abroad. In contrast, do not include immigrants who were already diagnosed abroad, i.e. previously positive before immigration – these are to be entered separately in AIM Incidence > HIV+ immigrants (see step 12 below). 
When entering or revising new diagnoses, please also update any older entries that may have been revised because of delays in notifications or missing reports from a specific region or facility. If complete diagnosis numbers are not available or cannot be estimated for a year, the data for that year should be left blank, rather than entered as 0. CSAVR assumes that cells with 0 had no diagnoses or deaths.
If you suspect that new case diagnoses were in some years affected by interruptions in HIV testing, compare numbers of new diagnoses (entered in CSAVR) with numbers of HIV tests (entered in AIM, Program Statistics), by calculating (e.g. in Excel) the ‘Test Positivity Rate’. When testing policy and targeting have not changed, you expect a stable test positivity rate, and so fewer diagnoses in the case of fewer tests. In the case of disruptions in testing services, e.g. during COVID-related lockdowns in 2020 and/or 2021 or humanitarian crises, a fall in test volume may spur a corresponding fall in new diagnoses. In principle, include these diagnosis numbers into CSAVR, to capture the effect on (slowed) progress in knowledge of status. In principle, CSAVR’s incidence estimate should be robust against temporary falls in new diagnoses. Only if the fitted incidence curve shows a sudden drop not consistent with a stable test positivity rate, you may consider dropping that year of diagnoses data.
After entering, updating and reviewing the CSAVR data inputs, click Ok. 

[bookmark: _Toc1347175783][bookmark: _Toc252180729][bookmark: _Toc219095931]Enter reported AIDS deaths to fit in CSAVR 
Enter adult AIDS-related deaths, for adults 15+ years overall and if available by sex and by age group. These should preferably be adjusted for incomplete reporting and misclassification in cause of death (e.g., garbage codes). The IHME has compiled publicly reported vital registration data from all countries, for the 2020 Global Burden of Disease (GBD) study, and applied the recommended adjustments. See: 
https://www.thelancet.com/journals/lanhiv/article/PIIS2352-3018(21)00152-1/fulltext .
UNAIDS recommends that CSAVR estimates use the IHME dataset, for years available. However, prior to CSAVR entry and fitting, the adjustments should be reviewed for plausibility, triangulated with other HIV epidemiology data sources and local expertise, especially in countries with stipulated large proportions of missing causes of death and/or garbage codes. 
In cases where the IHME’s adjusted AIDS deaths are not believed to be plausible or consistent with other HIV surveillance sources, this finding should be fed back to UNAIDS and the IHME HIV and Causes of Deaths team, for their consideration in future GBD revisions. In these few cases, the country may exceptionally be justified to not use the IHME misclassification-adjusted death data, however the reasons for discarding the standardized dataset should be justified up front. In no case should a country discard the standardized, adjusted dataset and default to original unadjusted deaths just for the reason of preferring a lower-level epidemic estimate – if there is no independent objective reason for that.   
[bookmark: _Hlk91063364]Exceptionally, countries with a 2C classification in the IHME’s 2019 Global Burden of Disease study*, i.e. poor completeness and/or quality of Vital Registration, should not input death data (neither country-reported nor IHME-adjusted) into CSAVR. The IHME country groups are defined in Section 2.3 of the supplementary material (page 5) and depicted in Figure S1 on page 6 of: https://www.thelancet.com/cms/10.1016/S2352-3018(21)00152-1/attachment/7371c03e-887f-4e26-a718-bae190b81c2f/mmc1.pdf
Countries in groups 2A and 2B, with acceptable cause of death data, can try out and compare fits between original reported and IHME/GBD-adjusted deaths, entering both data sets in parallel as Source 1 and Source 2. You may also enter a combined dataset, e.g. as Source 3, which is a good choice provided there is not a major scale difference between the two datasets. For both case diagnoses and deaths, sex- and/or age-specific data can be entered for years in which they are reasonably complete or representative, even if you do not have this disaggregation for every year or for all diagnoses. If age data are believed to be biased (e.g., only up to age 40 years), however, do not enter them. 
Note: CSAVR will fit age patterns to case or death data only for years with entries for all age groups: either a positive value or a written 0. Likewise, data for both sexes is required to include in fitting the sex distribution recorded in a given year. For both case diagnoses and deaths, enter sex- and/or age-specific data for years in which they are reasonably complete or representative, even if you do not have this disaggregation for every year or for all diagnoses. CSAVR will tolerate if sex-specific case or death numbers do not sum to the total (i.e. some had unknown sex) and if the sum across age groups do not match the 15-years and older total (i.e. some had unknown age). It will fit age and sex patterns to the proportional distribution of sex and age data entered. 

[bookmark: _Toc59463526][bookmark: _Toc742621185][bookmark: _Toc219095932]Enter CD4 at diagnosis data for CSAVR to fit
New diagnoses by category of CD4 count at diagnosis can optionally be entered, for the new diagnoses entered higher up in the CSAVR data entry. CD4 count data should only be used for years that they are reasonably complete or at least representative, covering at least 80% but preferably 95% or more of all new HIV diagnoses. 
The CD4 cell categories in CSAVR are: <200, 200-350, 350-500 and >500 counts per µL.
Countries that use CSAVR should always enter New case diagnoses data, plus either or both of: (i) AIDS-related deaths, or (ii) CD4 cell counts at diagnosis data. CSAVR would fit curves even if only one of these three sources is available, but would not have enough information to distinguish trends in new HIV diagnoses from underlying HIV incidence trends. Typically, death data are more complete and of better quality than CD4 data; the latter are to be included more optionally, if representative of all new diagnoses, and retained in fitting only if the result is judged (visually) to improve the fit. 

[bookmark: _Toc797867396][bookmark: _Toc895507979][bookmark: _Toc219095933]Estimate the HIV incidence trend using CSAVR
Having entered the country data, fit incidence to them, selecting the Fit Incidence menu item within the Fit Incidence to CSAVR menu.
On this panel, first review in the graphs the new HIV diagnoses and AIDS-related death data entered. The data show as black diamonds. Examine any outliers (e.g. sudden jumps or drops in a single year), to understand whether these reflect true changes or anomalies of the reporting or vital registration system for those years. You may click on the Select Model tab, to see HIV diagnoses and AIDS-related deaths separated by sex.
Next, select the data (new HIV diagnoses, and AIDS deaths and/or CD4 distribution) to include in the fitting process in the right-hand panel on the top of the Model Fitting form. It is recommended that the model first be run using only data that are of high quality. Other fits using additional data could be done if the initial fit is not satisfactory. 
Next, in the left-hand panel on the top, select the type of incidence models to be fitted:
Double logistic curve 
Single logistic curve
Splines with 3, 4 or 5 knots
rLogistic.
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The type of incidence model chosen should depend on the shape you expect for your country’s incidence trend, and on the resulting consistency with ART program data. For countries with evidence that incidence has already peaked and is now declining, the Double Logistic fit may work best. Countries with evidence for ongoing increases in incidence may find the Single Logistic fit option more appropriate. The Spline and the rLogistic options are for incidence patterns too complex to describe with either the Single or Double logistic curves. 
Of note, of CSAVR’s 6 models only the rLogistic model explicitly accounts for the effect of ART on reducing transmission, via the ‘Omega’ parameter (see Step 6). The rLogistic model is not recommended, however, if you do not have accurate data on the number of people on treatment over time.
In case of temporary disruptions in both case notifications and numbers of people on ART in recent years, due to socioeconomic or health system crises (e.g. COVID-19), the rLogistic and Spline models may be too sensitive and over-fit the recent decline. If you suspect under-reporting of both diagnoses and ART numbers in recent years, you may prefer either a more structured model which constrains the fit to be gradual (e.g. Double or Single logistic) – or try a relatively constrained Spline model with fewer (3 or 4, not 5) knots. 
Under Model parameters, for each incidence model, you may choose to fit or not, alongside the overall incidence and mortality trend, also the incidence rate ratios (IRRs) between sex and/or age groups. Fitting these ratios to the country’s case and death surveillance data will generally improve your incidence estimates. If you choose this (recommended) option, after fitting incidence in CSAVR, next update AIM’s Sex/Age pattern editor and select Pattern from CSAVR (Step 14), so that AIM will use the IRRs that CSAVR fitted as most plausible for your country.
If you use CSAVR for the first time, and especially if in AIM you will import CSAVR’s Knowledge of Status estimate, make sure you specify the year of first HIV diagnosis in the Model parameters form. Once this screen has been reviewed, click Ok to exit.

While the curve you used last year may still work well, we recommend exploring most or all 6 incidence models, after each annual data update. Alternatively, at minimum select for fitting the 3 models that typically work best: Double logistic, rLogistic (provided ART program data are reliable) and Spline with 5 knots.
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Having specified all these parameters and settings for CSAVR fitting, the Fit selected models button can be clicked. Fitting will take some time, typically 20 minutes per model on an ordinary desktop or laptop. As fitting progresses, you will see at the bottom, the model fitting progress bar showing progress from 0% (in red on white background) to 100% (on green background). Once model fitting is complete (showing 100%), below the progress bar, the Akaike information criterion (AIC) value is provided. This value informs which models statistically perform best: the ones with lower AIC value. AIC values from different incidence models should only be compared across CSAVR curve types fitted to the same dataset for new HIV diagnoses and AIDS deaths. Generally, model AIC values that are within 10 points of each other suggest equally plausible fits. 
If the AIC values are this similar, view the graphs in the Model comparison tab to help visually select the model that best represents your understanding of the local epidemic. The Model Comparison tab displays several indicators, one at a time: new HIV diagnoses, HIV-related deaths, Knowledge of Status, Mean CD4 count at diagnosis, Adults living with HIV and numbers of New HIV infections among adults. 
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Next, on the tab ‘Select model’, results are available overall and by sex for 4 key indicators side-by-side.
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Once you have selected the best fitting incidence model,  press Ok to accept that fit. This will send the incidence trend that CSAVR estimated back to AIM. If you chose to adjust IRRs during fitting, these also get sent to AIM.
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[bookmark: _Toc1325560110][bookmark: _Toc1409961540][bookmark: _Toc219095934]Step 12.	Nosocomial paediatric infections
In addition to sexual and mother-to-child transmission and intravenous drug usage, some HIV infections may occur during medical procedures, due to nosocomial or iatrogenic transmission. For example, injections with contaminated syringes may transmit HIV and other bloodborne pathogens. Such nosocomial infections have caused HIV outbreaks in hospitals in several countries. 
For adults, these nosocomial infections are captured within EPP (as External infections) or CSAVR (or another adult incidence model) and their output to AIM. For children, in contrast, incidence is not estimated by EPP or CSAVR, so nosocomial infections remain to be added into AIM. 
[bookmark: _Toc1739695126][bookmark: _Toc1930207272]If pediatric nosocomial infections were important in your country at any time, please enter their numbers, by calendar year and by age group (0-4, 5-9 and 10-14 years) into AIM > Incidence > Pediatric nosocomial infections. 

[bookmark: _Toc219095935]Step 13. HIV-infected immigrants in AIM
In all projections and countries, Spectrum adjusts the number of PLHIV every year for net migration (emigration or immigration) specified in the demographic projection. This background calculation assumes that immigrants and emigrants have the same (all-age) prevalence as non-migrants. 
A few countries have high net immigration and HIV prevalence that is substantially higher among immigrants than non-immigrants. As a result, immigrants make up a substantial proportion of PLHIV. 
Most of these countries fit incidence using CSAVR or the ECDC model to new diagnoses while excluding HIV-infected immigrants infected and diagnosed abroad before immigration, or they fit EPP without capturing HIV-infected immigrants in the configuration and surveillance prevalence data. 
For these cases, AIM has a special option, as the last menu item under AIM > Incidence, to input numbers of HIV+ immigrants by age. These immigrants will add to the PLHIV and prevalence that AIM estimates from the CSAVR/ECDC/EPP-based incidence trend, thus ensuring correct AIM estimates of PLHIV. 
Specifically, there are two use cases, depending on the incidence model:
1. Countries that use CSAVR or the ECDC model, fit to new diagnoses (including among immigrants), can add to AIM the HIV+ immigrants who were known positive i.e. previously diagnosed prior to immigration. This way, all immigrants are entered once: new diagnoses into CSAVR or ECDC model, and known positive or previously diagnosed into AIM. 
If you entered previously positive immigrants into AIM, and accept (‘Load’) in AIM a CSAVR estimate of Knowledge of Status, the latter will automatically count those known positive immigrants. However, if Knowledge of status numbers are not from CSAVR but entered as Program data (or an ECDC model estimate), then include all immigrants living with HIV (i.e., newly diagnosed entered into CSAVR or ECDC model, plus known positive also entered into AIM) into the known PLHIV numbers (i.e. count them all into cumulative diagnoses, before subtracting cumulative deaths and cumulative emigrations).

2. EPP-Concentrated countries can enter all immigrants living with HIV, regardless of the country of first diagnosis, into AIM’s immigrant tab. These same numbers of immigrants living with HIV must then also be counted into cumulative diagnoses used to calculate knowledge of status numbers (as in use case 1). 
· EPP-Concentrated countries may optionally also add HIV+ immigrants, within EPP by specifying External HIV infections, for one or more of the (non-migrant) subpopulations for which EPP fits an incidence curve. Still, these same numbers should also be added into AIM (by age and sex instead), for AIM to reproduce incidence, prevalence and PLHIV all closely matching EPP. 

In contrast, countries using Shiny90 for knowledge of status (with EPP-Generalized or EPP-Concentrated as the incidence model) should not use AIM’s HIV+ immigrant option. These models already count all immigrants within Shiny90, through the testing data inputted. Moreover, these are typically countries where immigrants contribute little to the overall HIV burden, with net e-migration and relatively higher prevalence compared to net immigration countries. 
If your immigration data covers only selected years, try to create valid AIM entries over a longer period, notably up to the latest year with data. You may impute immigrant numbers for missing years, for example assume the same annual number as the year before or after (ideally, adjusted for annual population growth or for the trend in PLHIV), and for intermediate years with missing data, linearly impute between the year before and after. Also impute an age/sex distribution if the data don’t have this, documenting your method in an external Excel file. These imputations should help to stabilize the trend in PLHIV and in people knowing their status. 
For years in which you entered immigrants living with HIV into AIM, Spectrum suppresses the automatic background calculation of net immigration, to avoid double-counting. Please view the Results > New HIV+ migrants, to verify that the resulting net immigration of PLHIV and its trend over time is plausible -- without unrealistic fluctuations between years with and without data. If there is much immigration but also much e-migration of PLHIV, entering the immigrant data without subtracting (typically unknown) emigrant counts risks to inflate the PLHIV estimate, and it may be better to not enter immigrants but default to AIM’s background (net-migration) calculation. 
Finally, countries with net emigration of PLHIV may specify this in AIM by entering negative HIV+ immigrant numbers.

Note: The above instruction used the term immigrants to denote non-resident, new immigrants, as well as migrant workers who return home after having lived abroad. Adding HIV infected immigrants of this second group into AIM introduces a small, but negligible demographic bias; this is acceptable for the sake of correcting PLHIV numbers. In contrast, immigrants who contract HIV after migration are included within the incidence estimate, no matter which incidence model. 
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[bookmark: _Toc364394484][bookmark: _Toc1964705641][bookmark: _Toc219095936]Step 14. Set the pattern of incidence by sex and age in AIM
The Sex/age pattern section in AIM specifies the distribution of HIV incidence by sex and age, in the form of incidence rate ratios (IRRs). Spectrum uses these IRRs to disaggregate overall adult incidence trends obtained from the incidence model (EPP, AEM or CSAVR).

[image: ]

[bookmark: _Toc219095937]Set Incidence Rate Ratios by sex and age
Both distributions can be specified via the “Epidemic pattern” radio buttons:
•	Choose a default epidemic pattern: Generalized, Concentrated non-IDU or Concentrated IDU, based on the epidemic type in your country.
[bookmark: _Hlk91064382]•	Pattern from CSAVR: If you used CSAVR and chose to adjust sex and age IRRs during CSAVR fitting (see step 11), then you must select this option, so AIM will use the same IRRs (by sex and age) as CSAVR.
You may use the “Custom” checkbox to allow manual editing of the sex and/or age pattern for one or more years. If you used AEM or EPP for concentrated epidemic settings, you may import the sex ratio from those models by ticking the “Read sex ratio from EPP or AEM” checkbox.

Note: If your file has the Goals module active, sex ratios estimated by Goals will overwrite those set or selected in AIM. To avoid confusion or errors, for the final AIM HIV estimates file de-activate Goals.

[bookmark: _Toc237554645][bookmark: _Toc1957262500][bookmark: _Toc219095938]Fit Incidence Rate Ratios by age
If your country has had a household survey with HIV testing and/or entered ART data by age in the Program statistics form in AIM for all age groups, you can use those data to estimate incidence rate ratios by age. To do this, in the Sex/age pattern form select “Pattern fitted to HIV prevalence or ART”, then press “Fit incidence ratios”. If this button is greyed out, uncheck “Custom” to activate it. When pressed, a new form will pop up. How that form looks will depend on which kind of data you entered in Program statistics (ART by age): 
Fitting to HIV prevalence data by sex and age: If your country has HIV prevalence survey data (preloaded in Spectrum, for most published national surveys), you can fit incidence rate ratios by age and sex, that are either fixed or time-dependent. Choose either model, then press “Fit incidence ratios”. This will launch a model fitting that will take some time. As model fit proceeds, the graph updates to show the current fit. You may select which sex or survey to display. Once fitting is complete, the ‘Akaike information criterion’ for that model will be updated and turn green. You may wish to fit, in turn, both fixed and time-varying models, then choose the one that has the lower, preferred, Akaike information criterion. Use the charts in the fitting tool to review the selected model's fit to HIV prevalence data. Be aware that fitting time-varying patterns may overfit noisy survey estimates. Check that estimated trends in new HIV infections by age are plausible; if they are not, the fixed pattern over time is more appropriate even if its Akaike information criterion is higher. In the rare case that neither fixed nor time-varying patterns produce plausible estimates, and you have data on ART by age, you may consider fitting the sex/age pattern to those data instead (see below).

Fitting to ART data by age: If you do not have a national HIV serology survey but did enter ART by age data into AIM Program Statistics, you will instead see the form below. Here, you may press the “Fit incidence ratios” button to estimate incidence rate ratios by age. Fitting will take some time; the graph will update as fitting progresses. You may select which sex to display via the radio buttons, and you may select which year to display using the “Prev year” and “Next year” buttons.

[image: ]

If your country has HIV prevalence data and you have entered ART by age data, you can use the “Data Source” radio buttons to choose which of these two data types to use.

Note: When using ART by age data, make sure numbers entered for adults add up to the overall numbers that you entered for 15+ men and women, otherwise the age pattern fitting may not perform well.

Note: If you entered ART by age data in GAM age groups only and fitted incidence rate ratios to those, review the resulting incidence patterns carefully. GAM age groups are wide and may not constrain incidence patterns well. For best results, enter ART by five-year age groups if possible. If detailed age data are not available, and fitting IRRs to GAM-reported ART by age produces implausible age patterns, revert to a default age pattern instead.

[bookmark: _Hlk119055763][bookmark: _Toc57632948]Note: If you use CSAVR as the incidence model with case diagnoses or deaths stratified by age, do not fit ART data by age. Rather, after CSAVR fitting, evaluate the CSAVR-based ART by age against the data, in Validation > ART by age. Only if this validation shows that Spectrum's estimates are not well-aligned with the ART data, you may consider fitting IRRs to your ART by age data, provided you trust those.

	Incidence model
	Cases and/or deaths in CSAVR by sex/age
	ART data by 5-age group entered

	
	
	Yes
	No

	


CSAVR
	Without Sex or Age
	· Adopt default Concentrated epidemic (age and sex) pattern
· Fit IRRs to ART by 5-year age group
	· Keep default Concentrated epidemic (age and sex) pattern

	
	Sex, not Age

	· If CSAVR last round had fitted age/and sex (case and/or death) data, keep the fitted IRRs as starting point, by keeping patterns ‘From CSAVR’
· Fit CSAVR incl. IRR by Sex and/or age (as available); 
in AIM, Sex/Age pattern, keep ‘Pattern from CSAVR’
· In Validation, assess ART by age. 
Only if CSAVR’s fit for ART by age is poor, go back and Fit to ART by age.

	
	Age not Sex

	· 

	
	Age & Sex
	· 

	ECDC model
	· Select and manually enter Custom sex ratio, from external model
· Fit IRRs to ART by 5-year age group
	· Select and manually enter Custom sex ratio, from external model

	Direct incidence
	· 
	· 

	EPP-Concentrated 
or AEM
	· Read sex ratio from EPP or AEM.
· Fit IRRs to ART by 5-year age group
	· Read sex ratio from EPP or AEM
· Select default age pattern, by type of epidemic

	EPP-Generalized
	· If survey-based HIV prevalence data by age are available, fit to those
· Otherwise, use default generalized epidemic pattern




[bookmark: _Toc871191748][bookmark: _Toc173978053][bookmark: _Toc219095939]Step 15.	Validation
This tab allows you to compare Spectrum results to other information as a validation step. 
All countries with accurate, nationally representative PMTCT data will want to assess if ART coverage for adults is consistent with ANC data on women already on ART at the time of the pregnancy. This validation offers a predicted adult ART coverage, based on the proportion of pregnant women entering Antenatal Care and already on ART at the time of their first ANC visit (entered under Program statistics > PMTCT). If the prediction and the program-based estimate are not close, it may indicate problems with one of the sources. 
Countries with one or more national household serosurvey should compare and validate ART coverage as estimated in the model against ART coverage measured in the survey(s). In ‘Validation > ART > Does ART coverage estimated from program data match survey estimates?’, read-in survey-measured ART coverage, if available. In the resulting Comparison chart, AIM will compare modelled ART coverage (i.e. program statistics ART numbers divided by AIM-estimated need) with survey-measured ART coverage measured in a national survey, like a PHIA or a DHS. 
Spectrum derives the survey-based coverage estimate by multiplying the proportion on ART from the survey by Spectrum’s estimated number of people living with HIV by age and sex. Three displays are available for this validation:
· ART coverage by age (for 1 survey year)
· ART coverage over time (showing all surveys, if they measured coverage for the selected age group)
· Number on ART from surveys and program data (for 1 survey year).
The visual comparison will not change the estimates. However, a mismatch between model-based and survey-based ART coverage could prompt your review of: 
· Routine program data of numbers of PLHIV on ART 
· The denominator, PLHIV: Does EPP/AIM-estimated HIV prevalence match the survey? If not, why not?
· The overall denominator, total population size: If prevalence does match, is the overall population incorrect
· The survey-based ART coverage estimate.
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Another validation visualises the movement in the national ART patient cohort over the latest 2 years with data, in terms of new initiations, treatment interruptions, re-initiations i.e. re-engagements, and deaths. This ‘waterfall’ display shows, in parallel, any program data you enter, and the Spectrum estimate. The Spectrum-based cascade is based on user-entered numbers for people on ART, reinitiations and treatment interruption rates, and it calculates new initiations and deaths. and reinitiations, the user-entered annual percentage of treatment interruption, and Spectrum-estimated mortality. 
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Under Validation > Prevalence, you can compare the projected HIV prevalence by age group against survey results, and the number of people receiving ART as estimated by Spectrum by age group. 
In addition, all-cause mortality (under five, 15+ or other standard mortality indicators) in the overall population and AIDS-related mortality data can be compared to what Spectrum estimates. 
[bookmark: _Toc474851182][bookmark: _Toc57632949]These comparisons and validations between AIM results and country data sources should all be done before finalizing the estimation file.


[bookmark: _Toc1212289668][bookmark: _Toc1235665957][bookmark: _Toc219095940]Step 16.	Results
Select the Results menu item to see a drop-down menu with categories of HIV/AIDS indicators. They are:
Dashboard
Total population
Adults (15-49)
Adult 15+
Adults 50+
Young adults (15-24)
Adolescents (10-19)
Children (0-14)
Children under 1
Children 1-4
Children under 2
PMTCT
ART – Dec 31
Sub-populations. This imports from an EPP and AEM model the estimated population size, new infections, incidence rate, prevalence and PLHIV for all subpopulations (adults 15+ years) for which a separate incidence trend was modelled.
Key Population estimates (under Adults 15+ sub-menu only): For countries in sub-Saharan Africa, if the KP workbook was completed, Spectrum will display estimated new infections, HIV prevalence, ART coverage and population size estimates based on this – both here and in the ‘Programs statistics > Key populations’ editor. 
AIDS impacts
Orphans

Each category contains indicators that Spectrum can display. Choose one of these indicators, for example, HIV population, HIV prevalence, people living with Advanced HIV Disease, PLHIV with Cryptococcal Antigen infection or clinical Cryptococcal Meningitis, or Cryptococcal Meningitis deaths as subset of AIDS deaths (details in Annex 3).
The Treatment-adjusted prevalence (i.e. prevalence of HIV among people not on ART (https://www.ncbi.nlm.nih.gov/pmc/articles/PMC8640683/ ) may be useful for understanding expected testing yields.

For any indicator, the menu below will appear, where you can tailor the display:
1. Chart type. Select the type of chart you wish to display. 
Sex. By default, this is set to display both sexes, but you can change it to male or female only. 
Display interval. By default, this is set to display every year. 
First year and Final year. By default, this is set to the first and final year of your projection – typically 1970 and 2030. 
A
B
C
D


Once you have set the options, click Ok at the bottom of the screen. This will display a chart showing the indicator you have chosen, according to the variables you have selected on the previous screen. The following is an example of a line graph: 

[image: ]

The user can also display results for specific age groups, from the Total Population page. Options to display results for HIV age distribution 0-80 years allow the user to define which age group should be included in the presented results. 

[image: ]

You can open up to 10 projections at one time and display the results in the same chart. The name of each projection that you open will appear at the bottom of the screen. 

[bookmark: _Toc1718330778][bookmark: _Toc714083300][bookmark: _Toc227058964][bookmark: _Toc57632950][bookmark: _Toc227058961][bookmark: _Toc474851183][bookmark: _Toc219095941]Surveillance data requirements for a valid, publishable incidence trend estimate
Every year UNAIDS publishes country-approved, national Spectrum-based HIV estimates for all countries with populations of 250 000 or more (according to the United Nations Population Division World Population Prospects 2024). The estimates must also meet standard requirements on data inputs, methods and coherence of results. 
Publishing the historical incidence trend depends on the quantity and quality of historical surveillance data. Incidence trends from EPP or AEM models are published if four or more prevalence data were entered and fitted, including one or more datapoints within the past four years for the most important modelled sub-populations. In the 2025 round, this last rule means at least one data point from 2020 or later.
For low-level and concentrated epidemics estimated based on HIV case and AIDS death reports, incidence trends are published if based on at least eight datapoints on AIDS-related deaths and eight years of case diagnoses data, both within 1990-2025.
More information on UNAIDS’ publication and aggregation of country, regional and global HIV and cascade estimates is in the Annex on Methods of the July 2025 global AIDS report, Annex 1 Methods for deriving UNAIDS HIV estimates — 2025 Global AIDS Update — AIDS, Crisis and the Power to Transform. UNAIDS-approved country estimates from the 2025 round can be found at http://aidsinfo.unaids.org .


[bookmark: _Toc57632951][bookmark: _Toc369082840][bookmark: _Toc1888927793][bookmark: _Toc227731818][bookmark: _Toc185942673][bookmark: _Toc219095942]Step 17.	Check file completeness and save the projection
On the Validation tab, click Check File Completeness to ensure that all key steps have been completed. Address any issues that are labelled as False.
Then, save the projection by clicking the Spectrum menu button and selecting Save or Save As or by selecting Home and clicking the Save icon. Please be sure the file name includes the country name. 

[bookmark: _Toc219095943]Step 18.	Uncertainty analysis
Spectrum can calculate the range of plausible values for each of the output indicators. To use this feature you should open one, and only one, projection. If you have more than one projection open the uncertainty menu option will not appear. 
To start an uncertainty analysis, select Tools from the main menu and then click on more tools, then on Uncertainty Analysis icon as shown in the visual below. 
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You will see a display like below.
The column labeled ‘s.d.’ shows the standard deviation (as a proportion of the mean value) used in the uncertainty analysis. You can change any of these standard values if you wish to try a larger or smaller range. The uncertainty analysis will randomly select parameter values for each of these indicators for each iteration. 
By default, the number of iterations is set to 300. It will take 10-15 minutes to generate 300 runs. You can test the procedure by changing this to a smaller number, but you should generate 300 curves for the final estimate. 
When you are ready to go, click the ‘Process’ button to start the analysis. When it is finished click the Save button to save the results. Once you have run the uncertainty analysis, most of the displays will show the 95% plausibility bounds. Note that bounds will only be shown when a single projection is open. If you open multiple projections, then the bounds will not be shown. 
Other tools are available on the Tools menu. The most used tools include:
Extract: to extract indicators from multiple Spectrum files. The results are written to a CSV file. 
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Description automatically generated]Aggregate: to aggregate multiple Spectrum files. This is useful for aggregating sub-national files to get national totals. 
[bookmark: _Toc474851184][bookmark: _Toc57632952][bookmark: _Toc992523878][bookmark: _Toc929740042]
[bookmark: _Toc219095944][bookmark: _Toc227058963]Step 19.	Compare with last year’s projection
If you want to compare your new projection with a previous one (without changing that) you can open the latter as a ‘Read Only’ projection. Click on the Spectrum menu icon in the upper left corner of the Spectrum window and select ‘Read Only’ then select the previous projection. You will now have two projections open in Spectrum. Any chart you display will show both the current and the comparison projection so that you can see what has changed. You can use the editors to see the inputs to the comparison projection, but you will not be able to change anything. Whereas Spectrum re-projects the current projection, it will not re-project the comparison projection. This maintains the integrity of the previous projection and uses it only for comparison purposes. 
In general, you can compare projections by creating and opening two or more files that have the same inputs except for one indicator that you wish to examine. For example, you might want to see the effect on AIDS deaths of increasing ART coverage. The easiest way to do this is to start by opening the base file. Then open the same file again. When you try to do this, Spectrum will recognize that you are trying to open the same file twice, and ask you if you want to go ahead and do this, or if you want to rename the 2nd projection as you load it. If you choose to rename it, you can provide a new name, such as ‘Expanded ART’. Then you will have two projections open that are the same but with different names. You can then edit the ‘Expanded ART’ variant and change the projected ART coverage. Then, under Results, display the number of AIDS deaths, which will be shown for the 2 projections alongside (2 series of lines or bars on a chart, or 2 rows or columns in a table) to see the effect of expanded ART coverage. 
When multiple projections are open, Spectrum will display the names of the projections at the bottom of the screen and show an asterisk next to the active projection. This is the projection that will appear when you edit the data. To edit a different projection, click the Set Active button (when the Modules menu item is selected) and select the projection to edit. 
[bookmark: _Toc474851187]

[bookmark: _Toc57632954][bookmark: _Toc1554529027][bookmark: _Toc632401279][bookmark: _Toc219095945]ANNEX 1. Managing Templates
What is a template and how do I use it?
Templates are predefined national epidemic structures for use in EPP. The various templates provided each consist of a number of special sub-populations (i.e., specific groups of people affected by HIV epidemics) that tend to occur frequently in national epidemics globally.
The three default templates provided automatically in EPP, and the associated sub-populations are:
Urban Rural (G) – a template for use in generalized epidemics
Urban – the national population living in urban areas
Rural – the national population living in rural areas.
Concentrated (C) – a template for use in concentrated epidemics
IDU – the national population of injecting drug users 
MSM – the national population of men who have sex with men 
Sex work clients – the national population of men who visit female sex workers regularly
Sex workers – the national population of female sex workers
Male remaining pop – all men in the country not in one of the other groups
Female remaining pop – all women in the country not in one of the other groups.
Any template can be applied to a national epidemic (or to a sub-epidemic) by right-clicking on that epidemic in the “National Epidemic Structure” tree on the Define Epi Page (see figure below).
You then just select a template in the list and click on it and the sub-populations defined it in will be added to the national epidemic structure for your country.
Creating your own templates describing your local epidemic situation
Suppose you have your own special set of epidemic structures. Consider, for example Vietnam, where there are often two distinct epidemics among people who inject drugs, one among older PWIDs and one among younger PWIDs. Since this occurs in many provinces, they may want to define this particular structure one time and then apply it repeatedly in a number of provinces. 
For assistance with creating unique or advanced epidemic structures please request assistance from your UNAIDS strategic information adviser or write to estimates@unaids.org.


[bookmark: _Toc474851188][bookmark: _Toc57632955][bookmark: _Toc1582553198][bookmark: _Toc2064640891][bookmark: _Toc219095946]ANNEX 2. Creating a new population projection
When you create a new projection, you will see the “Projection manager” dialogue box.
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Follow these steps to complete the “Projection manager” screen: 
1. Click the Projection file name button and enter a file name for the projection. 
The First year and Final year should be set to 1970 and 2030. You can change them if you wish, but projections submitted to UNAIDS should use these settings. 
For projections using AEM (AIDS Epidemic Model), the first and final year should be respectively 1975 and 2050.
Click the check box next to AIDS (AIM) to add the AIM module to the projection. 
Then click the Default Data button. A list of countries will appear. Once you select your country from the list Spectrum will automatically load all the demographic data you need for your projection. 
Spectrum will load data on HIV incidence, and number of people receiving ART, cotrimoxazole and PMTCT services from data published by UNAIDS and WHO. It is important that users compare these inputs with their program data and make any revisions that might be necessary. In particular, the data provided on PMTCT and ART services should be reviewed. 
When you are done click the OK button. 



[bookmark: _Toc219095947]ANNEX 3. Methods for Estimating Advanced HIV Disease and Cryptococcal Meningitis

Advanced HIV disease: Definition (by WHO) 
Advanced HIV Disease (AHD) is defined as adults and children 5+ living with HIV with CD4 counts under 200/mL or WHO Stage III or IV disease plus all children living with HIV under the age of 5. 

Advanced HIV disease: Spectrum implementation
AHD is estimated comprising seven categories of people living with HIV: 

AHD = all children aged 0-4 living with HIV
	+ children aged 5-14 living with HIV not on ART with CD4<200 copies/mL
	+ adults living with HIV not on ART with CD4<200 copies/mL
	+ adults on ART for less than one year with CD4<200 copies/mL and not virally suppressed
	+ adults on ART for less than one year with CD4<200 copies/mL with viral suppression
	+ adults on ART for more than one year with CD4<200 copies/mL and not virally suppressed
	+ adults on ART for more than one year with CD4<200 copies/mL with viral suppression.
[bookmark: _Hlk183443302][bookmark: _Hlk183689229]
For adults on ART, the proportions of each category assumed to have AHD were estimated from data from 20 national household PHIA surveys conducted over 2016 to 2021 in 14 sub-Saharan African countries, as follows: 

	Category
	Proportion with AHD

	Adults on ART for < 1 year, not virally suppressed
	0.25

	Adults on ART for < 1 year, with viral suppression
	0.06

	Adults on ART > 1 year, not virally suppressed
	0.14

	Adults on ART >1 year, with viral suppression
	0.01


 
The implementation in Spectrum uses viral load testing and suppression data entered into 2024 Spectrum files, although viral suppression information was only available for some years and the years of available data vary by country. Years missing viral suppression data have been estimated using a random effects model using ART coverage to predict viral load suppression among those on ART. This produced a complete time series of viral suppression for the period 2015-2024, which was preloaded into 2025 and 2026 Spectrum files and is consistent with country-supplied data. 

Details are forthcoming in Stevens-O, et al. Estimating Advanced HIV Disease in Sub-Saharan Africa.

Cryptococcal Meningitis: Definition
Cryptococcal meningitis is a fungal infection of the brain and spinal cord. It is the most common cause of meningitis among people living with HIV and a major cause of AIDS death. 

Cryptococcal Meningitis: Spectrum implementation
The methods in Spectrum for estimating cryptococcal meningitis indicators are based on an approach developed by Radha Rajasingham and colleagues (Rajasingham-R et at. The global burden of HV-associated cryptococcal infection in adults in 2020: a modelling analysis. Lancet Infect Dis 2022:22: 1748-55.  https://doi.org/10.1016/ S1473-3099(22)00499-6 ).

The number of PLHIV with cryptococcal antigenemia (CrAg) is estimated from the prevalence of CrAg by county and region as estimated by Rajasingham et al. from available survey data (Rajasingham et al. Supplemental Table 2). 

Rates of progression from cryptococcal antigenemia to clinical cryptococcal meningitis (CM) and death from it vary depending on whether the person is receiving care or not. By default, estimates of the proportion in care for CrAg are from Rajasingham-R et al. as shown in Table 1. 

Table 1. Proportion of CrAg+ PLHIV in care for CrAg
	Population
	Percent in Care for CrAg

	HIV status unknown
	50%

	HIV status known but not on ART
	60%

	On ART
	95%



Progression to cryptococcal meningitis is estimated separately for six groups, as listed in Table 2. 

Table 2. Proportion of PLHIV with CrAg progressing to cryptococcal meningitis
	Knowledge of HIV status
	ART status
	Status of Care for CrAg
	Progressing to Meningitis

	Status unknown
	Not on ART
	Not in care for CrAg
	95%

	Status unknown
	Not on ART
	In care for CrAg*
	78%

	Known positive
	Not on ART
	Not in care for CrAg
	95%

	Known positive
	Not on ART 
	In care for CrAg*
	78%

	Known positive
	On ART
	Not in care for CrAg
	95%

	Known positive 
	On ART
	In care for CrAg*
	78%

	Known positive
	On ART
	Receiving fluconazole
	11%



* In care for CrAg


[bookmark: _Toc219095948]ANNEX 4. Importing a custom adjusted population file
In exceptional cases, if a new Census has become available after the WPP’s 2024 update, if the WPP-based projection does not match official national statistics, you may opt to overwrite the WPP 2024 with a ‘custom population adjusted file’, as follows:

1. Create a Custom population adjustment CSV file:

· Put the population by single year of age and by sex as rows 3-84 for Men and rows 86-167 for Women, with calendar year as columns: 1970 as column B etc. until 2030 in column BE or farther right for a later projection end year. 

· You may create the population age/sex distribution over time by entering census data for the census years, then interpolating smoothly for years between censuses. A linear interpolation would produce sharp changes in the annual growth rates. A better option is to use an interpolation method that produces a smooth growth rate curve. Avenir Health has prepared a small R script that can be used to impose a piecewise cubic hermite interpolation that will produce a smooth interpolation. You can request that script from Avenir Health (within Spectrum, select ‘Home > Online Support > Contact Us’) or create your own.

2. Open the Spectrum file
3. Go to Modules > DemProj > Projection parameters
4. Check the box labelled ‘Use custom population adjusted file’

5. Click ‘Load data’ and select your external file, for example ‘Demo proj Mex 2022.csv’
6. Change the ‘Last year of rescale’ to match the last year for which your external file provides population numbers.
7. Click ‘Ok’.

8. In AIM > Results, display any indicators to force the re-projection. 
Spectrum will exactly match the population estimates in the external file.
To make the match, Spectrum adds a small amount of migration each year. 
You can see the additional migration added, under 
DemProj > Results > Population > Visualize population adjustment

9. Once you have done this, Spectrum stores the values from the population file in this PJNZ file, so it will retain this externally calibrated population without needing the CSV file anymore. UNAIDS
20 Avenue Appia
CH-1211 Geneva 27
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+41 22 791 3666
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